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Description of menus and buttons

In the event that menu and button names on a Windows
system are different from those on a Mac, this manual uses
the Windows menu and button names followed by the Mac

menu and button names in parentheses.
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Getting Started

Overview of CL Editor

CL Editor enables you to remotely control a Yamaha CL mixing console (such as CL5, CL3, or CL1; hereinafter collectively
called “CL” in this document). CL Editor also enables you to save the parameter settings on your computer.

Configuring CL Editor

[ASystem Setup

To open the System Setup dialog box, choose [System Setup] from the [File] menu.

(1) Network 3 System Setup =
Specify the IP Address of your CL console to com- Network
municate. Console
IP Address .
@ Model Select Model Select
Select the model of your CL (CL5/CL3/CL1) when — © cu ©® cL3 @ cLs

CL Editor is not synchronized with the CL console.
If CL Editor is synchronized with the CL console,
the model will automatically be selected and other
model options will be grayed out.

(3 Channel Select/Sends On Fader
This checkbox enables you to specify whether or
not the CL console and CL Editor are linked to each

Channel Select / Sends On Fader
i— | Link between the PC and the console

Synchronization Confirmation

—:ZI Autometically synchronize on file load Store Confirmation

[7] Recall Confirmation ( : )

Window Control From Console O FzEnEritme

© Q9 @@P@Pﬁ?

other for the following operations: [ 2 Enabie StealPateh Confmaton
° Selecting channels Level Meter Administrator Password
« Switching between normal mode and SENDS [ e —T1®
ON FADER mode
—— Set Default oK Cancel
o Switching between MIX and MATIRX in S [ | l
SENDS ON FADER mode

« Selecting [CUE] buttons
If you do not check the box, the CL console and CL Editor will operate independently.
If the box is not checked, the [CUE] button will be hidden in each window.

(@ Synchronization

This allows synchronization to be done automatically when a CL Editor file is loaded. This function is enabled by
default.

& Window Control From Console

This option determines whether or not using the USER DEFINED KEYS on the console enables you to remotely open
and close the CL Editor windows.

(6 Level Meter

This option specifies whether the level meter functionality will be enabled. By disabling the meter function you can
reduce the processing load caused by screen drawing and communication.

(@ Confirmation
These check boxes specify whether a confirmation dialog box will appear when you store (Store Confirmation), recall
(Recall Confirmation), patch (Patch Confirmation), or make a patch change that would modify an existing patch (Steal
Patch Confirmation).

Administrator Password

Enter the Administrator password that was specified on the CL console. If this password is not entered correctly, it will
not be possible to synchronize from CL Editor to the CL console.
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(9 Set Default

Press this button to use the settings (except for the IP Address in the Network section) currently specified in the System
Setup dialog box as the default settings. The next time when you start up CL Editor, it will use these settings.

A Mixer Setup

To open the Mixer Setup dialog box, choose [Mixer Setup] from the [File] menu.

(D Mix Bus Setup

Here you can make settings relating to the MIX buses.

Signal Type: Choose either MONOx2 or STEREO for each M-
two adjacent odd-numbered/even-numbered MIX buses. - % Storen " ® 5.1 Suroumd
In Surround mode, choose surround buses (L, R, C, LFE, Ls, (HEEEET
RS) for MIX buseS 1—6 Signal Type Bus Type/Send Point Pan Link
Mix 1/2 MONOx2 * | |VARIPRE FADER) hd
Mix 3/4 MONOx2Z ¥ | | WVARIPRE FADER) hd
Surraund Setup ]
btz 1 Miz¢ 2 Wiz 3 Miz¢ 2 Wiz 5 Miz: 6 WcSE | MONGHS | | MAKEREEATE
Mix 718 MONOx2 * | |VARIPRE FADER) hd
[L h ] ’R b ] [C i ] [LFE h ] [LS i ] [RS h l Mix 810 MONOx2Z ¥ | |WARIPRE FADER) hd
@ Mix 1112 MONOx2 - WARIPRE FADER} -
Bus Type/Send Point: Choose either VARI (PRE M 1314 MONNE 7, |VARKPRE FADER) v
f h t d t Mix 1516 | MONOx2 ¥ | |WARIPRE FADER) hd
FADER) or VARI (PRE EQ) or FIXED for each two adjacen M 17116 [MONORZ = | (VARKPREFADER)
odd-numbered/even-numbered MIX buses. Wi 18720 |MONOx2 = | |VARKPRE FADER) =
Pan Link: The PAN setting for signals sent to stereo MIX Mix 21122 |MONOND: | (VARKPRE FADER)
buses will link to the PAN setting for the STEREO bus. This | M (HONO2 v VARPREFADER) T
parameter is valid only if the Signal Type is set to STEREO [ Wit Bus Setup ——
and the Bus Type is set to VARI. Signel Type or Input Channels Pan Link
. Matrix 122 |MONOx2 [« |PREFADER [+]
(@ Matrix Bus Setup @1 werxan [wowoe [+] |PREFaDER =]
Here you can make settings relating to the MATRIX buses. Matrix 55 |MONGx2 [+ | |PREFADER =]
Signal Type: Choose either MONOx2 or STEREO for each | MR [wovoe ] [ereraver =]
two adjacent odd-numbered/even-numbered MATRIX
buses | Ok | [ Cancel l

Send Point for Input Channels: Choose either PRE
FADER or PRE EQ for each two adjacent odd-numbered/even-numbered MATRIX buses.

Pan Link: The PAN setting for signals sent to stereo MATRIX buses will link to the PAN setting for the STEREO bus.

This parameter is valid only if the Signal Type is set to STEREO.

(3 Surround Mode

Here you can make settings for Surround mode.
Stereo: Selects standard Stereo mode.
5.71Surround: Selects Surround mode.

(dZoom Function

Access the [Zoom] menu to select a screen zoom ratio: [100%)] (default), [150%], or [200%].

@ cL Editor

File Edit Windows Synchronization View | Zoom | Help

-~

CH1-16 v k
CAMTE] DAMTE?2  DAMTEYX  DARMTE4  DAMTER ) 150% U DA

0 0dE 0048 004 0 o0dE 0 0dE
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dCreating a user key

To open the Create User Key dialog box, choose [Create User Key] from the [File] menu.

This creates a user key (with “CLU” file name extension) that can be read from a USB flash drive by the CL console to
automatically set user-specific parameters.

A B I B

@ create t— (ey ’ X
User Name Comment | | POWER USER
Password : Re-Enter Password l:l e
@—— ACCESS PERMISSION
CH OPERATION e T CURRENT SCENE
NPUT INPUT

a0 7 PATCH NAME
O e e 9. @99 . @ @@ e e e 0 e e SE:__L:_E'P
OO0 200210202802 O0602700200300310) 312 ouTPUT BT
Oxn030s030x37080x000 Oa0L068Qu0sQs0a0) =8 PATCH NANE

Q000020800 50% OO0z A
OO0 nOnnr

— STIN o RACK 1 RACK 2 RACK 3 RACK 4
OLORO20xROALOROALOR OsOmOeeOerO O RO 8r T soran sora SoEiE
WX - _

O1 0203040506 0708 Q8 OQuOuQzQBQ Q1580 16 RACKS || RACK10 || RACK1 || RACK12
® 9 -9 909 -9 =9
MATRIX - ~ STIMONO

@ @ @ 04 Os Os O7 (Os (O smwreoL () STEREOR () MONO(C) EFFECT RACK
La= RACK 1 RACK2 || RACK3 RACK 4
® @:e:e e:@e-e @ @9 o @ -9 9 @& @ -

RACK 13 RACK 14 RACK 15 RACK 16

RACK 5 RACK & RACKT RACK &

Set by One Click HA PROCESSING FADER/ON PREMIUM RACK
RACK 1 RACK2 || RACK3 | RACK4
SCENE LIST FILE LOAD MONITOR SETUP
(:) || store SYSTEM SETUR ||| Racks | Racke | Rack7 | Racks
JSORT RECALL USER SETUP ‘ ‘ MONITGR SETUR OSCILLATOR TALKBACK 50L0
LIBRARY LIST SYSTEM SETUP
. ‘ MUTE GROUP ‘ ‘ MUTE GROUP
| | STORE CURRENT SCENE LIBRARY MIXER OUTPORT ASSIGN CONTROL
JCLEAR L2t SCENE LIST LIST SETUF SETUP e Las

@ @ @ ®

(1) User Name

Specify the name of the user. You can enter up to eight single-byte alphanumeric characters.

(@ Comment
Enter a comment for each user. You can enter up to thirty-two single-byte alphanumeric characters.

(3 Password
Enter a password that will be used when this user key is read by the CL console. You can enter up to eight single-byte
alphanumeric characters. Uppercase and lowercase are distinguished.

(4 Re-Enter Password

Enter the password once again as a safeguard against mistaken entry.

(5 POWER USER
Specify whether this user is a power user. Power users can use the CL console to create or edit a user authentication key
with a specified user level.

(6) Administrator Password
Enter the Administrator password that was specified on the CL console. This is not required if no Administrator pass-
word has been specified on the CL console, but if this password is incorrect you will be asked to enter it when the user
key is read.

(D ACCESS PERMISSION

In this area, specify the parameters that this user will be allowed to operate.
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CH OPERATION
INPUT, ST IN, MIX, MATRIX, ST/MONO, DCA: Select the channels whose parameters will be operable.

HA: Change the operating privileges for the head amp gain (analog gain) and phantom power of the selected chan-
nels.

PROCESSING: Change the operating privileges for overall signal processing parameters (except for fader and
[ON] button) of the selected channel. For the specific parameters included in PROCESSING, refer to the CL’s man-
ual.

FADER/ON: Change the operating privileges for the pan/balance, fader, channel on, send on/off, and send level of
the selected channels.

Set All: Turn on HA, PROCESSING, and FADER/ON for all channels.
Clear All: Turn off HA, PROCESSING, and FADER/ON for all channels.

Set by One Click: If this button is on, pressing the channel select button repeatedly will set HA, PROCESSING,
and FADER/ON to On or Off simultaneously.

(© SCENE LIST
STORE/SORT: Change the operating privileges for scene store and sort operations.
RECALL: Change the operating privileges for scene recall operations.

LIBRARY LIST
STORE/CLEAR: Change the operating privileges for library store and clear operations.
RECALL: Change the operating privileges for library recall operations.

() FILE LOAD
USER SETUP: Change the operating privileges for loading user-defined keys and preferences when loading a file.

SYSTEM SETUP MONITOR SETUP: Change the operating privileges for loading system setup and monitor

setup settings when loading a file.

CURRENT SCENE: Change the operating privileges for loading the current scene when loading a file.
SCENE LIST: Change the operating privileges for loading the scene list when loading a file.

LIBRARY LIST: Change the operating privileges for loading the library list when loading a file.

1 CURRENT SCENE
INPUT PATCH: Change the operating privileges for input patch operations.
INPUT NAME: Change the privileges for editing the input names.
OUTPUT PATCH: Change the operating privileges for output patching.
OUTPUT NAME: Change the privileges for editing the output names.
BUS SETUP: Change the operating privileges for buses.
GEQ 1-16: Change the operating privileges for GEQ (Graphic Equalizer) rack operations.
EFFECT: Change the operating privileges for EFFECT rack operations.
PREMIUM RACK: Change the operating privileges for PREMIUM rack operations.
MUTE GROUP ASSIGN: Change the privileges for assigning mute groups.
MUTE GROUP CONTROL: Change the operating privileges for enabling/disabling mute groups.

(3 MONITOR SETUP
OSCILLATOR: Change the operating privileges for oscillator settings.
TALKBACK: Change the operating privileges for talkback settings.
SOLO: Change the operating privileges for SOLO settings.

SYSTEM SETUP
MIXER SETUP: Change the privileges for making mixer setup settings.
OUTPORT SETUP: Change the privileges for making outport setup settings.
MIDI/GPI: Change the privileges for making MIDI and GPI settings.
DANTE: Change the privileges required to make Dante network settings.

(5 Create

Creates the user key.

Cancel
Closes the dialog box.
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Handling Files

The following table describes how to handle files.

Creating a new file Choose [New] from the [File] menu.
Opening a previously saved file Choose [Open...] from the [File] menu.
Saving the current file Choose [Save] from the [File] menu.
Saving the current file with a new name Choose [Save As...] from the [File] menu.
Quitting the CL Editor Choose [Exit] from the [File] menu.

Files dedicated for CL Editor have a filename extension of ““CLE” Files in which only the CL console data is saved (file-
name extension “CLF”) can also be handled, allowing you to use a USB flash drive to exchange data with the CL console.

Importing and Exporting CSV Files

Importing a CSV File [File] menu — [CSV File Import]

Exporting a CSV File [File] menu — [CSV File Export]

CSV support is provided to allow data to be edited and transferred between devices.

Importing CSV Files

Channel names (and colors and icons), input patching, output patching, and other patching data (such as output port or
rack patching information) will be imported into CL Editor. When you execute this, a dialog box appears, allowing you to
choose the folder containing the CSV files to be imported.

Q Choose a folder where CSV files are located. @
@Uv 3 » Libraries » Documents » - | &,| Search Documents 2 |
Organize v Mew folder EE=E 4 .@.

4 Y Favorites Name Date modified Type Size

Ml Desktop | Files 10/4/2011 2:20 PM File folder
& Downloads =

= Recent Places

4 Libraries
> 3 Documents
> J’ Music
> &= Pictures
> B8 Videos

L .
1M Computer Sla | m o

Folder: Documents

[ Select Folder ] ’ Cancel ]

If a supported CSV file does not exist in the specified folder, those settings will not be imported.

For example if the folder contains only an input patching CSV file, only the input patching settings are imported, and the
remaining parameters do not change.
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Exporting CSV Files

Channel names (and colors and icons), input patching, output patching, and other patching data (such as output port or
rack patching information) will be exported to CSV files. When you execute this, a dialog box appears, allowing you to
select an export format.

Data Form

@ Short (v4.0 form)

[] Export Comments of Detailed Form

Normal (v4.1 form)

Short format: CL/QL Editor V4.0.0 and V4.0.1 file format
Normal format: CL/QL Editor V4.1 file format
In V4.1, CSV files can be read in both Short format and Normal format.

If you select the [Export Comments of Detailed Form] check box, data that is not omitted from the comment line (line 3)
is added and output to the CSV file.

Press the OK button. A dialog box appears, allowing you to choose the folder to which the CSV files will be exported.

The respective data is exported as CSV files to the selected folder. If a channel name includes a comma, the comma is
enclosed in double quotation marks when the name is exported.

"o

(,—",")If a channel name includes a double quotation mark, it is converted into two double quotation marks. (" — ")

Added specifications for the CSV file read function
When creating a CSV file, you can use a synonym or acronym as a notation.

@® Channel color notation

Original notation Notation when reading a CSV file
Blue BL, B

Orange OR, O

Yellow YE, YL, Y

Purple PU, P

Cyan SkyBlue, CY, C

Magenta Pink, PK, M, MG

Red Brown, RD, BN, R

Green GN, G

Off Black, BK, (Treated as Off if there is no notation.)

This notation is not case sensitive.

® Channel icon notation

Original notation Notation when reading a CSV file
Kick BassDrum, B.Dr, BD, B.D

Snare Sn, S.Dr, Botm, Botom

Hi-Hat HiHat, HH

Tom RackTom, F.Tom, Ftom, LTom, HTom

Drumkit Drum, Kit, Drums, Top, TopL, TopR, O.HEAD, O.H
Perc. Percussion, Per, Cong, conga, Bong, Bongo
A.Bass AcousticBass, Bass, C.Bass, CB, C.B, AB, A.B, Vc
Strings String, Str, VI, Vn, Via

E.Bass ElectricBass, E.B, EB

A.Guitar A.Gt, AcousticGuitar, AcousticGt, A.G, AG
E.Guitar E.Gt, ElectricGuitar, ElectricGt, E.G, EG
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Original notation Notation when reading a CSV file
BassAmp B.Amp, B.A

GuitarAmp GtAmp, G.Amp, G.A

Trumpet TP, Trp

Trombone Tb, Trb

Saxophone Sax, SSax, ASax, TSax, BSax

Piano Pf, AP, PfL, PfR, PfH

Organ Org, Leslie

Keyboard KB, Key, KeyL, KeyR, EP, E.Pf, Syn, EPL, EPR, SynL, SynR
Male

Female

Choir Chorus, Cho, Chor

Dynamic DynamicMic

Condenser CondenserMic

Wireless WirelessMic, W/L, W.L

Podium Speech, Lecture

Wedge Foot, Flor, Floor

2way

In-Ear InEar, IEM, Ear

Effector Fx, Eff, Effect

Media1 CD, MD, DISC

Media2 PB

Video VTR, DVD, Blu

Mixer Mix

PC DAW

Processor DME, DSP, DLY, DELAY, REV, Reverb
Audience Aud

Star1

Star2

Blank (Treated as Blank if there is no notation.)

e This notation is not case sensitive.
e Spaces within the notation are not recognized.

® Port name notation for input patches and output patches

Original notation Original notation fdditiopal notation when rez_zding a CSV file
(Normal format) (Short format) ; Uncljer!lned words can be omitted.
[n] indicates a number (such as a channel number).
NONE NONE None
DANTE [n] DNT [n] Dante [n]
OMNI [n] OMNI [n] %“Friﬂ[”]
INPUT [n] INPUT [n] Input [n]
PB L PBL Playback Output Left
PB R PBR Playback Output Right
SLOT1 [n] SL1[n] Slot1 [n]
SLOT2 [n] SL2 [n] Slot2 [n]
SLOT3 [n] SL3[n] Slot3 [n]
FX [n] A FX[n]A Effect Rack [n] A
FX[n] B FX[n]B Effect Rack [n] B
PRFX [n] A PR[nJA Premium Rack [n] A
PRFX [n] B PR[n]B Premium Rack [n] B
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Original notation

Original notation

Additional notation when reading a CSV file
* Underlined words can be omitted.

(Normal format) (Short format) * [n] indicates a number (such as a channel number).

GEQ[n] A GEQ[n]A GEQ Rack [n] A
GEQ[n] B GEQ[n]B GEQ Rack [n] B
MIX [n] MX [n] Mix Channel [n]
MATRIX [n] MT [n] Matrix Channel [n]
STEREO L STL Ste.reo Output Left

Main L
STEREO R STR Stereo Qutput Right

Main R
MONO (C) MONO Mono (C)
STEREO L+C STLC Stereo Output L+C
STEREO R+C STRC Stereo Output R+C
MONITOR L MON L Monitor Left
MONITOR R MON R Monitor Right
MONITOR C MON C Monitor Center
CUEL CUEL gzg feﬁ
CUER CUER Cue Right
CUEBL CUE BL Cue B Left
CUEBR CUE BR Cue B Right
INS CH [n] IC [n] Insert1 Input Channel [n]
INS MIX [n] IM [n] Insert1 Mix Channel [n]
INS MATRIX [n] IMT [n] Insert1 Matrix Channel [n]
INS STEREO L ISTL Insert1 Stereo Output Left
INS STEREO R ISTR Insert1 Stereo Output Right
INS MONO (C) IMONO Insert1 Mono (C)
DIR CH [n] DI [n] Direct Input Channel
CAS MIX [n] CMX [n] Cascade Mix [n]
CAS MARIX [n] CMT [n] Cascade Matrix [n]
CAS STEREO L CSTL Cascade Stereo Left
CAS STEREO R CSTR Cascade Stereo Right
CAS MONO (C) CMONO Cascade Mono (C)
CAS CUE L CCUE L Cascade Cue Left
CAS CUER CCUER Cascade Cue Right
CASCUEBL CCUE BL Cascade Cue B Left
CASCUEBR CCUE BR Cascade Cue B Right
INS2 CH [n] IC2 [n] ::zgﬁ%hgssgrﬁ][”]
INS2 MIX [n] IM2 [n] :Ezgﬁiyﬁﬁ][”]
INS2 MATRIX [n] IMT2 [n] ::zgﬁa'\t’:sﬂc"h;hs—(ml[”]
INS2 STEREO L ISTL2 ::zgg;;e;%fﬁeﬁ
INS2 STEREO R ISTR2 :222’3;?;%’_&%??”
INS2 MONO (C) ISTMONO2 Insert2 Mono (C)
SUR MONITOR L SMON L Surround Monitor Left
SUR MONITOR R SMON R Surround Monitor Right
SUR MONITOR C SMON C Surround Monitor Center
SUR MONITOR LFE SMON LFE Surround Monitor LFE
SUR MONITOR LS SMON LS Surround Monitor Ls
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- . . . Additional notation when reading a CSV file
Original notation Original notation . ) .
Underlined words can be omitted.
(Normal format) (Short format) R
[n] indicates a number (such as a channel number).
SUR MONITOR RS SMON RS Surround Monitor Rs
MONITOR MATRIX L MMT L Monitor Matrix Left
MONITOR MATRIX R MMT R Monitor Matrix Right
MONITOR MATRIX C MMT C Monitor Matrix Center
MONITOR MATRIX LFE | MMT LFE Monitor Matrix LFE
MONITOR MATRIX LS MMT LS Monitor Matrix Ls
MONITOR MATRIX RS MMT RS Monitor Matrix Rs

Undo/Redo Function

e This notation is not case sensitive.

e This notation is recognized even if spaces are added between each word, or if the word order is changed.
However, the notation will not be recognized if a space is added in the middle of a word.

In CL Editor, you can cancel the latest operation (Undo) and also cancel the cancellation of the latest operation (Redo). If
you perform an Undo operation twice in a row, you can cancel the two most-recent operations. If you perform an Undo
operation three times in a row, you can cancel the three most-recent operations. In this way, you can cancel multiple recent

operations.

The following table describes how to use the Undo/Redo function.

Undo

Choose [Undo] from the [Edit] menu.

Redo

Choose [Redo] from the [Edit] menu.

Please note, however, that after you perform one of the following operations, you cannot successfully undo or redo any
previous operation:

o+ Operations on the CL console
« Synchronizing with the CL console

You cannot Undo or Redo the following operations:

e FEdits in the Setup window
e Synchronization

e Opening and closing the windows

e Resizing or moving the windows

There are certain other operations that cannot be undone, depending on the function.

For library or scene operations, Undo/Redo applies only to the single most recent operation. You cannot
undo any operations prior to this. Undo/Redo in these windows is available only using the [UNDO] but-
ton within the respective window. Even if you perform a scene recall from the Main window, you cannot
use a shortcut or menu operation to undo the recall.
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Window operations

You can select and open each window from the [Windows] menu.

_

File Edit

Synchronization View Help

Close Ctri+w
Close All Ctri+Alt+W

Tile Ctrl+T
Cascade Ctri+Alt+T

Master Ctrl+1
Sends On Fader Ctrl+2

CH1-16 Ctrl+Alt+1
Custom Fader Bank CH17-32 Ctrl+Alt+2
Selected Channel CH33-48 Ctrl+Alt+3
Library CH49-64 Ctrl+Alt+4

FEam R S CHeS-72 Ctrl+Alt+5
Patch Editor

Rack

Meter

MIX1-16 Ctrl+Alt+7
MIX17-24 Ctrl+Alt+8
Group/Link MATRIX Ctrl+Alt+9
Scene STEREQ/MONO  Ctrl+Alt+0

Custom Fader Bank Setup DCA
User Defined Keys Setup

User Defined Knobs Setup

Outport Setup

You can choose Tile or Cascade to arrange the windows within the editor.

® Tile

@® Cascade

Pamw

BT @ cLeino

|55 e Svdows mvamasion v

[ ko gt g

NP

.

patch o

In the Library window or Scene window, click the tabs located at the top of the window to switch between pages.

W—
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Synchronizing CL Editor

When CL Editor starts up, the parameter settings on the console and the parameter settings in CL Editor may be different.
Therefore, you must first match the parameter settings on the console with those in CL Editor. This operation is called
“synchronization.” Follow the steps below to synchronize CL Editor.

1 Select [Synchronization], then [Re-synchronize]. '® Re-synchronize B
The following window opens.
X L . Direction Contents
If CL Editor is in the offline status the . P
[Re-synchronize] function is not available. )
@ PC-=Console Dante Setup and VO Device

2 Select whether you want to transfer your settings to
CL Editor, or vice versa. [ oK ] [ Cancel
Console -> PC: Transfers the current parameter settings of
your console to the CL Editor.
PC -> Console: Transfers the current parameter settings in CL Editor to your console.
At this time, the All Libraries option determines whether or not Library data is synchronized.
If you select the [Dante Setup and I/O Device] check box, Dante settings will also be synchronized. Clear this check box
if you want to preserve the Dante settings of the CL console when using PC -> Console.

e The Dante settings of the CL console will be copied to CL Editor if you clear this check box and select
PC -> Console, or if you select Console -> PC.

e During synchronization using the PC -> Console option, if the CL unit contains read-only scenes, a
dialog appears asking you whether you want to copy the read-only scenes to CL Editor. If you select
not to copy, the read-only scenes will not be synchronized.

If you recall a read-only scene that is not synchronized, the operation between the CL unit and CL Editor
will not be synchronized.

3 Click [OK].

A Do not operate the console while synchronization is in progress.

Offline Edit Function

If you do not want to synchronize your console with CL Editor, select [Offline Edit] from the [Synchronization] menu. To
apply your off-line edits to your console, select [Re-Synchronize] from the [Synchronization] with the PC -> Console
option to synchronize the console with CL Editor.
The Offline Edit function is also activated when you click the [ONLINE]/[OFFLINE] button in the Main window.
Some effect parameters in the console change their displayed values depending on the sampling fre-
quency. If you switch CL Editor from OFFLINE to ONLINE, displayed parameter values may change
because CL Editor loads the sampling frequency from the console and updates the display.

Other Functions

[JResetting to the default value (Ctrl(38)+click)

Move the cursor to a control or a parameter value, then hold down the <Ctrl>(< 8 >) key and click the mouse button to
reset the value to the default (e.g., to reset a pan setting to Center).
However, the channel faders and the send knobs and bar graphs can be set to —oo regardless of the default value.

ACtrl(38)+Shift+Click

Move the mouse cursor to a channel fader or to a send knob or bar graph, and click while holding down the
<Ctrl>(< & >) key and <Shift> key to set the nominal value regardless of the default value.
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SYNC

RE-SY¥HC

SCENE MEMORY

gEs -

Initial Data

In the Main window you can synchronize to the CL itself, recall scenes, and display the Overview window. To open this
window, choose [Main] from the [Windows] menu.

(JCHANNEL SELECT

This indicates the number and name of the channel to which your operations will apply. To
switch channels, you can either click the [SELECT] button and choose from the list that
appears, or you can click the plus/minus (+/-) channel select buttons on the left or right side
- [CH1 of the icon. You can also use the channel name text box to edit the name.

ch 1 If the Channel Select/Sends On Fader checkbox in the System Setup dialog box is selected,
this parameter is linked with the [SEL] buttons on the CL console panel.
You can right-click (<control> key + click) the icon to select a different one. You can also left-
click the icon to select a channel color.

SELECT

ASENDS ON FADER

_ This button indicates whether normal mode or SENDS ON FADER mode is engaged. Click
the button to switch modes. When SENDS ON FADER mode is engaged, the Sends On Fader
window appears. (= p.110)

SENDS OM FADER If the Channel Select/Sends On Fader checkbox in the System Setup dialog box is selected,
this parameter will be linked with the SENDS ON FADER mode setting on the CL console.

13 CL Editor Owner’s Manual



ASYNC

This indicates the status of connection and synchronization between CL Editor and the CL.

(1) [ONLINE]/[OFFLINE] button
The ONLINE/OFFLINE status will alternate each time you click this button.
This has the same function as [Synchronization] menu =>[Offline Edit]. (= p.12)

% OHLIHE This indicator is shown when CL Editor is correctly connected to

the CL itself. In this state, the parameters of CL Editor and the CL
itself are linked.

OFFLIME This indicator is shown when CL Editor and the CL itself are not
connected, or when there is a problem with the connection, or when
Offline Edit is selected. In this state, the parameters of CL Editor
and the CL itself are not linked.

(@ [RE-SYNC] button
Clicking this button opens the Synchronization dialog box.

This has the same function as [Synchronization] menu => [Re-Synchronize]. (= p.12)

eyl If CL Editor is in the offline status the [Re-synchronize] function is not avail-
able.

ASCENE MEMORY

Here you can view the currently-recalled scene, and recall or store scenes.

(1 Scene number display
Indicates the number of the scene that is selected for store or recall.

(@ Protect indicator

The lock icon is displayed for scenes that are protected. You will be unable to overwrite or
modify the titles of such scenes. For read-only scenes, “R” appears instead.

(3 Edit indicator

The edit indicator will light when you edit the parameters after recalling a scene.

(4 [STORE] button
This button stores the current scene into the number shown by the scene number display

(@).
(3 [INC]/[DEC] buttons

These buttons increment or decrement the number shown in the scene number display
(D). The scene number display (D) will blink until you actually store or recall, and while
blinking will not match the scene number indicated on the CL.

(® [RECALL] button

This button recalls the scene of the number shown in the scene number display ).
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(dBank Select Keys

Opens the corresponding window in the Overview window.
These are not linked with the bank select key section on the panel of the CL itself.

INPUT

1 [1-16] button
Opens the INPUT CH 1-16 window.

@ [17-32] button
Opens the INPUT CH 17-32 window.

(3 [33-48] button
Opens the INPUT CH 33-48 window.

(@ [49-64] button
Opens the INPUT CH 49-64 window (only CL5/CL3.)

(%) [65-72] button
Opens the INPUT CH 65-72 window (only CL5.)

® [ST IN] button
Opens the ST IN window.

@ [DCA] button
Opens the DCA (Digital-Controlled Amplifier) window.

OUTPUT

OUTPUT

1H|1+ 17-24 MTRH & [1_16] button

Opens the MIX CH 1-16 window.

(© [17-24] button
Opens the MIX CH 17-24 window.

[MTRX] button
Opens the MATRIX window.

@ [ST] button
Opens the STEREO/MONO window.

CUSTOM FADER

@ [A1]/[A2] button (CL1: [A1] button)
Opens the CUSTOM FADER bank A1/A2 window.

@3 [B1] button (CL3: [B1]/[B2] button, CL1: [B1]-[B4] button)
Opens the CUSTOM FADER bank B1 window.

[C1]-[C6] button (only CL5)
Opens the CUSTOM FADER bank C1-C6 window.

CUSTOM FADER
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Overview window

INPUT CH window

CH1-16 @ @

DANTE 1 DANTE DANTE 3 DANTE 4  DANTE 3 DANTE 7 DANTE &  DANTE 3 DANTE 18 DANTE11 DANTE12

IHSERT

[fHA 1 [vHA 1 [HA 1 [HA 1 [HA 1 [HA 1 [ HA 1

DEL &' DEL &Y

This window displays the mix parameters of INPUT CH 1-16, 17-32, 33-48, 49-64 (only CL3/CLS5), or 65-72 (only CL5.)
The parameters shown in the window can be selected from the [View] menu or the menu that appears when you right-
click (<control> key + click) in the window.
You can access this window in the following ways.
o From the [Windows] menu, choose [Overview] and select CH 1-16, 17-32, 33-48, 49-64 (only CL3/CL5), or 65-72
(only CL5)
o Use the bank select keys in the Main window to turn on the [1-16] button/[17-32] button/[33-48] button/[49-64] but-
ton (only CL3/CL5), or [65-72] button (only CL5)
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D Input patch
Click here to select the input source that will be assigned to the INPUT CH, from the fol-
lowing choices.

NONE No assignment

DANTE 1-DANTE 64 DANTE INPUT 1-64
OMNI 1-OMNI 8 OMNI IN jacks 1-8

PB OUTL, PBOUTR L/R outputs of PLAYBACK
SLOT1-1, SLOT1-2...SLOT3-15,

Input channels of an I/O card installed in slots 1-3

SLOT3-16
FX1L(A), FX1R(B)...FX8L(A), FX8R(B) | L/R outputs of EFFECT rack 1-8
PR1L(A), PR1R(B), PR2L(A), PR2R(B) | L/R outputs of PREMIUM rack 1-2

@ HA (HA analog gain)
Drag the knob in the screen to adjust the analog gain of the internal head amp or of the
external head amp patched to the INPUT CH.

48V (Phantom power)
Switches on/off the phantom power (+48V) of the internal head amp or of the external head
amp patched to the INPUT CH.

Wireless device indication
If a wireless digital system receiver is connected and patched to an input port as a I/O
device, the head amp indication changes to a wireless device indication.

Gain level

RF (Radio Frequency) signal meter

MUTE indicator

Battery indicator

In Diversity mode, the RF signal meter will indicate the level for both channels A and B.

In Quadversity mode, the meter will indicate only the highest level among channels A
through D.

Indication of a device that does not feature Dante outputs

If you connect a device that does not feature Dante outputs, such as Shure AXT400, QLXD4,
or ULXD4, and patch it to an input port, the head amp indication will change.

This indication varies depending on the type of the patched device.

(Example) Indication if Shure AXT400 is patched
When the receiver is on and connected via a ShowLink® remote control

I The RF level is shown for two channels (A and B).
1Tk

. . . . 1®
When the receiver is on and not connected via a ShowLink™ remote control
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DRNTE 1 @@ (Phase)
Inverts the phase polarity of the signal after AD conversion.
(& Digital Gain
Drag the knob in the screen to adjust the input gain of each input channel.

(® HPF (High Pass Filter)

Switches the high pass filter on/off. You can drag the numeric value up or down to edit the
cutoff frequency.

@ INSERT

Enables/disables the insert-in.

D. OUT (Direct out)
Enables/disables the direct output.

(© EQ (Equalizer)
Switches the EQ on/off. The graph immediately below the button shows the approximate
response of the EQ. Double-click within the graph to open the Selected Channel window of
the corresponding channel. To open the Selected Channel window as an additional view,
hold down the <Ctrl>(< 8 >) key of your computer keyboard and double-click the graph.

DYNA1/DYNA2 (Dynamics 1/Dynamics 2)
Turns the two dynamics processors on/off.
If Gate is assigned (Dynamics 1 only), the status of the gate is shown immediately below the

button.
Gate status
indication === | — == — BN — — = — — —
On/off status On On On Off
Open/closed Closed Open Open —
status
Remarks Gain reduction amount | Gain reduction Gain reduction .
is 30 dB or more amount is 0—-30 dB | amountis 0 dB

If something other than Gate is assigned, a GR meter is shown immediately below the but-
ton, and the amount of gain reduction is shown while this is on.

The type for each dynamics processor can be selected in the Selected Channel window.
Double-click anywhere other than the DYN1 or DYN2 button to open the Selected Channel
window of the corresponding channel. To open the Selected Channel window as an addi-
tional view, hold down the <Ctrl>(< & >) key of your computer keyboard and double-click
anywhere other than the DYN1 or DYN2 button.

{@ DELAY

Turns the input delay processors on/off. The current delay value is shown in the numerical
box located immediately below the button. You can also edit the delay value in this text box.

@ MIX/MATRIX (MIX/MATRIX SEND)
Switches between the send indications to MIX buses 1-24 and to MATRIX buses 1-8.
The bar graphs located immediately below the button show the send level of the signals sent
from the INPUT CH to VARI type MIX/MATRIX buses. You can also drag the bar graph to
left or right to set the send level. While you drag the bar graph, the send level is shown in the
numerical display area for PAN/TO STEREO MONO ((9)).
You can set the minimum value (-e dB) by holding down the <Ctrl>(< & >) key of your
computer keyboard and clicking the bar graph, or set the nominal value (0.00 dB) by hold-
ing down the <Ctrl>(< 3 >) key and <Shift> key and clicking the bar graph.
The bar graph display will change according to the send position (pre/post) and on/off sta-
tus of the signal sent from the INPUT CH to the MIX/MATRIX buses.
To switch a send on/off, click the channel number located at the left of the bar graph.

For FIXED-type MIX buses, the bar graph is fixed at nominal level (0 dB),
Pre/on (green) and only the on/off status is shown.

==——um Pre/off (green) In SENDS ON FADER mode, this button enables you to adjust the send
Post/on (orange) level using the fader.

—m Post/off (orange)
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Surround Mode indicator

In Surround mode (= p.3), the Send indication for MIX buses 1-6 will
be switched to the surround panning and LFE level indication. Double-
click any part of the Surround Mode indicator to open the Selected
Channel window for the corresponding channel.

LFE -codE

@ PAN/ST/M(C)
The PAN knob adjusts the panning of the signal that is sent from the INPUT CH to the
STEREO bus L/R channels (or the L/C/R channels.) You can set this to the center value by
holding down the <Ctrl>(< & >) key of your computer keyboard and clicking this knob.
The [ST] button is an on/off switch for the signal that is sent from the INPUT CH to the
STEREO bus. The [M(C)] button is an on/off switch for the signal that is sent from the
INPUT CH to the MONO bus.
If LCR MODE is selected in the Selected Channel window, the [LCR] button will appear
instead of the [ST] button and [M(C)] button, and the [LCR] button will be an on/off switch
for the signal that is sent from the INPUT CH to the LCR bus.

SEL (Channel selection)
Selects the INPUT CH for which you want to perform operations.

{ CUE
This button cue-monitors the signal of the INPUT CH.
In the ONLINE state, if MATRIX bus channels 7 and 8 can be used as a second cue, the
indication shows “CUE A,” “CUE B,” or “CUE AB” depending on the settings of the
console.

If the Channel Select/Sends On Fader checkbox in the System Setup dia-
log box is not checked, the [CUE] button will be hidden in the screen.

1

A.BAdE

h 1 ®ON

Switches the INPUT CH or send on/off.
The button is color-coded and indicates status as follows:

White: INPUT CH is on (normal mode.)

Black: INPUT CH/Send are off.

Other colors: Send is on (SENDS ON FADER mode.)
(7 Fader

Adjusts the input level of the INPUT CH, or the send level.
The fader is color-coded and indicates status as follows:

White: You can adjust the input level of the INPUT CH (normal mode.)

Gray: INPUT CH is off.

Other colors: You can adjust the send level (SENDS ON FADER mode.)
The current fader value is shown in the numerical box located immediately below the fader.
You can set this to the minimum value (-eo dB) by holding down the <Ctrl>(< $ >) key of
your computer keyboard and clicking the fader knob, or set it to the nominal value
(0.00 dB) by holding down the <Ctrl>(< 8 >) key and <Shift> key and clicking the fader
knob.
The numbers and alphabetical letters at the right of the fader indicate the DCA group and
mute groups to which that channel belongs, and show the Recall Safe and Mute Safe status
of the channel.
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Mute Group indicator  DCA Group indicator Level Meter

The numbers of mute groups to
which this channel belongs are
shown in red when those groups are
muted. If the dimmer levels for those
groups are set in a non-default
status, those are shown in orange.

The numbers of DCA groups
to which this channel belongs
are shown in yellow.

This level meter is displayed
at the same metering point
with the input channel in
Meter window setup (= p.86.)

If this channel is set to Mute Safe,
the M character is shown in green.

If this channel is set to Recall
Safe, the R character is
H.884E A.864E shown in green. A.868d4E

e Click the indicator area to switch between 3 indicators.
e Drag & drop the area around the fader to move the channel (CH MOVE). While holding down the <Cltrl> (<& >)
key of your computer keyboard, drag & drop the area around the fader to copy the channel (CH COPY).
Channel number

This is the number of the INPUT CH. You can open the Selected Channel window for this channel by double-clicking
this number. If you hold down the <Ctrl>(< 3 >) key of your computer keyboard and double-click this, the Selected
Channel window will open as an additional view.

Channel name
This is a text box that displays the channel name. You can also edit the channel name in this text box.
You can right-click (<control> key + click) the text box to select a channel color.
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ST IN window

STIN @

DANTE 3 DRNTE % DANTES DANTE 6 [OANTE 7 DANTE S DANTE 3 DANTE1A  DANTET1  DANTE1R

In this window you can view and edit the mix parameters of ST IN channels 1-8. The parameters shown in the window can
be selected from the [View] menu or the menu that appears when you right-click (<control> key + click) in the window.

You can access this window in the following ways.
o From the [Windows] menu, choose [Overview] and then choose “ST IN”
o Use the bank select keys in the Main window to turn on the [ST IN] button

(D Input patch
Selects the input source that will be assigned to the ST IN channel. The input sources that
can be assigned are the same as for an INPUT CH (= p.17.)

@ HA (HA analog gain)

Drag the knob in the screen to adjust the analog gain of the internal head amp or of the
external head amp patched to the ST IN channel.

(3 48V (Phantom power)

Switches on/off the phantom power (+48V) of the internal head amp or of the external head
amp patched to the ST IN channel.

(@ @ (Phase)

Inverts the phase polarity of the signal after AD conversion.
(6 Digital Gain

Drag the knob in the screen to adjust the input gain to each ST IN channel.
(® HPF (High Pass Filter)

Switches the high pass filter on/off. You can drag the numeric value up or down to edit the
cutoff frequency.

(@ LR-MONO SELECT
Enables you to select STEREO, L-MONO, R-MONO, or LR-MONO for ST IN channel
mode.

EQ (Equalizer)
Switches the EQ on/off (the L/R settings are linked.) This is the same as the equalizer for
INPUT CH (= p.18.)
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(© DYNA1/DYNA2 (Dynamics 1/Dynamics 2)
These buttons switch the two dynamics processors on/off. This is the same as the
dynamics 1/dynamics 2 for INPUT CH (= p.18.)

DELAY

Turns the input delay processors on/off. The current delay value is shown in the numerical
box located immediately below the button. You can also edit the delay value in this box.

@ MIX/MATRIX (MIX/MATRIX SEND)
Switches between the send indications to MIX buses 1-24 or to MATRIX buses 1-8. This is
the same as the mix/matrix send for INPUT CH (= p.18.) In Surround mode, the Send
indication for MIX buses 1-6 will be switched to the Surround mode indication. (™ p.19.)

(@ PAN/BALANCE/ST/M(C)
Displays the PAN/BALANCE knobs for L/R channels. PAN/BALANCE is synchronized to
the Pan/Balance of the “TO STEREO/MONO” section. The BALANCE knob adjusts the
balance of the signal that is sent from the ST IN channel to the STEREO bus L/R channels
(or the L/C/R channels.)The PAN knob adjusts the panning of the signal that is sent from
the INPUT CH to the STEREO bus L/R channels. Other than the PAN/BALANCE knob,
this is the same as PAN/TO STEREO MONO for an INPUT channel (= p.19.)

(3 SEL (Channel selection)

Selects the ST IN channel for which you want to perform operations. (L and R can be
selected separately.)

CUE

This button cue-monitors the signal of the ST IN channel.
In the ONLINE state, if MATRIX bus channels 7 and 8 can be used as a second cue, the
indication shows “CUE A,” “CUE B,” or “CUE AB” depending on the settings of the

console.
If the Channel Select/Sends On Fader checkbox in the System Setup dia-
log box is not checked, the [CUE] button will be hidden in the screen.
15 ON
Switches the ST IN channel on/off.
A.6AdE The button is color-coded and indicates status as follows:
Rtil Rt 1R White: ST IN channel is on (normal mode.)
Black: ST IN channel/Send are off.
Other colors: Send is on (SENDS ON FADER mode.)
Fader

Adjusts the input level of the ST IN channel.
The fader is color-coded and indicates status as follows:
White: You can adjust the input level of the ST IN channel (normal mode.)
Gray: ST IN channel is off.
Other colors: You can adjust the send level (SENDS ON FADER mode.)
The current fader value is shown in the numerical box located immediately below the fader.
This is the same as the fader for INPUT CH (= p.19.)
e Click the indicator area at the right side of the fader to switch between 3
indicators (mute group indicator, DCA group indicator, level meter).
e Drag & drop the area around the fader to move the channel (CH MOVE).
While holding down the <Cltrl> (<3 >) key of your computer keyboard, drag
& drop the area around the fader to copy the channel (CH COPY).

@ Channel number
This is the number of the ST IN channel. You can double-click this number to open the
Selected Channel window for this channel. If you hold down the <Ctrl>(< 3 >) key of your
computer keyboard and double-click this, the Selected Channel window will open as an
additional view.

Channel name

This is a text box that displays the channel name. You can also edit the channel name in this
text box. You can right-click (<control> key + click) the text box to select a channel color.
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MIX window

DANTE 1 DANTE 2 DANTE 3 DANTE 4 DANTE 5 DANTE & DANTE 7 DANTE 3

[ 1 [He 1 [ 1 [ Hey 1 [ My 1

INSERT

INSERT

MATRIA

DANTE 18

In this window you can view and edit the parameters of MIX channels 1-24. The parameters shown in the window can be
selected from the [View] menu or the menu that appears when you right-click (<control> key + click) in the window.

You can access this window in the following ways.
o From the [Windows] menu, choose [Overview] and then choose “MIX1-16 or MIX17-24”
o Use the bank select keys in the Main window to turn on the [MIX1-16] button or [MIX17-24] button

(1) Output Patch

lowing choices.

Click here to select the output port that will be assigned to the MIX channel, from the fol-

NONE No assignment

DANTE 1-DANTE 64 DANTE OUTPUT 1-64
OMNI 1-OMNI 8 OMNI OUT jacks 1-8
RECL,RECR L/R inputs of RECORDER

SLOT1-1, SLOT1-2...SLOT3-16

Output channels of an I/O card installed in slot 1-3

FX1L(A), FX1R(B)...FX1L(A), FX8R(B)

L/R inputs of EFFECT rack 1-8

PR1L(A), PR1R(B), PR2L(A), PR2R(B)

L/R inputs of PREMIUM rack 1-2

DIGI L, DIGI R

L/R channels of the DIGITAL OUT jack

If multiple patches have been made, only the first port is shown.

If you change the patching in this window, the port that had been assigned until then will be
cancelled, and only the newly selected port will be assigned.

@ EQ (Equalizer)

Switches the EQ on/off. This is the same as the equalizer for INPUT CH (= p.18.)

(O DYNA1 (Dynamics 1)

Switches the dynamics processor on/off. This is the same as the dynamics 2 for INPUT CH

(= p.18.)
(@© INSERT

Enables/disables the insert-in.
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(5 MATRIX (MATRIX SEND)

These bar graphs indicate the send levels of the signals sent from the ~ * Pre/on (green)

MATRLA MIX channel to MATRIX 1-8 bus. You can also adjust the send levels
by dragging a bar graph to left or right. While you drag the bar graph, * Pre/off (green)

the send level is shown in the numerical display area for TO STEREO/
MONO. * Post/on (orange)
You can set the minimum value (-oo dB) by holding down the
<Ctrl>(< #>) key of your computer keyboard and clicking the bar
graph, or set the nominal value (0.00 dB) by holding down the
<Ctrl>(< #>) key and <Shift> key and clicking the bar graph.

The bar graph display will change as follows according to the send position (pre/post) and
on/off status of the signal sent from the MIX channel to the MATRIX buses.

To switch a send on/off, click the channel number located at the left of the bar graph.

(® PAN/BALANCE/ST/M(C)
The PAN knob adjusts the panning of the signal that is sent from the mix channel to the
STEREO bus L/R channels (or the L/C/R channels.) You can set this to the center value by
holding down the <Ctrl>(< & >) key of your computer keyboard and clicking this knob. If
assigned as a stereo bus, this adjusts the balance of the odd-numbered channel and even-
numbered channel. The stereo bus setting can be made in Mix Bus Setup of the Mixer Setup
dialog box.
The [ST] button is an on/off switch for the signal that is sent from the mix channel to the
STEREO bus.
The [M(C)] button is an on/off switch for the signal that is sent from the mix channel to the
MONO bus.
If LCR MODE is selected in the Selected Channel window, the [LCR] button will appear
instead of the [ST] button and [MONO] button, and the [LCR] button will be an on/off
switch for the signal that is sent from the mix channel to the LCR bus.

=N o N ey

* Post/off (orange)

|

5
El
]
[

Surround mode indicator (only for MIX channels 1-6)
In Surround mode, (= p.3), these controls enable you to adjust a downmix

L
R for MIX channels 1-6. Use the LEVEL knob to adjust the downmix coeffi-
cient, then use the [L] and [R] buttons to switch the signal on and off.

(@ VARI/FIXED
Indicates the type (VARI or FIXED) of the currently selected MIX bus. This parameter can
be switched in Mix Bus Setup of the Mixer Setup dialog box. In Surround mode, this param-
eter will not be displayed for MIX channels 1-6.

SEL (Channel selection)
Selects the MIX channel for which you want to make settings.

(@ CUE
This button cue-monitors the signal of the MIX channel.
In the ONLINE state, if MATRIX bus channels 7 and 8 can be used as a second cue, the
indication shows “CUE A,” “CUE B,” or “CUE AB” depending on the settings of the
console.

If the Channel Select/Sends On Fader checkbox in the System Setup dia-
log box is not checked, the [CUE] button will be hidden in the screen.

(1 ON

Switches the MIX channel on/off.
The button is color-coded and indicates status as follows:

White: MIX channel is on (normal mode.)

Black: MIX channel/Send is off.

Other colors: Send is on (SENDS ON FADER mode.)
i) Fader

Adjusts the output level of the MIX channel. The current fader value is shown in the
numeric box immediately below the fader. You can set this to the minimum value (-eo dB)
by holding down the <Ctrl>(< 3 >) key of your computer keyboard and clicking the fader
knob, or set it to the nominal value (0.00 dB) by holding down the <Ctrl>(< 3 >) key and
<Shift> key and clicking the fader knob.
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The numbers and alphabetical letters at the right of the fader indicate the DCA group and
mute groups to which that channel belongs, and show the Recall Safe and Mute Safe status
of the channel.

Mute Group indicator

The numbers of mute groups to
which this channel belongs are
shown in red when those groups are
muted. If the dimmer levels for those

DCA Group indicator

Level Meter

The numbers of DCA groups
to which this channel belongs
are shown in yellow.

groups are set in a non-default sta-
tus, those are shown in orange.

If this channel is set to Mute Safe,
the M character is shown in green.

This level meter is displayed—preuammm

at the same metering point _1|:|_-
with the input channel in A=

Meter window setup (= p.86.) [E{iE=

If this channel is set to Recall
Safe, the R character is
A.884E A.884E shown in green. A.884E

e Click the indicator area to switch between 3 indicators.

e While holding down the <Ctrl> (<3 >) key of your computer keyboard, drag
& drop the area around the fader to copy the channel (CH COFPY).

The fader is color-coded and indicates status as follows:
White: You can adjust the input level of the MIX channel (normal mode.)
Gray: MIX channel is off.
Other colors: You can adjust the send level (SENDS ON FADER mode.)

(2 Channel number
Indicates the number of the MIX channel. You can double-click this number to open the
Selected Channel window for this channel. If you hold down the <Ctrl>(< 3 >) key of your
computer keyboard and double-click this, the Selected Channel window will open as an
additional view.

@3 Channel name
This is a text box that displays the channel name. You can also edit the channel name in this
text box. You can right-click (<control> key + click) the text box to select a channel color.
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MATRIX window

[ Hé 1 LA 1

INSERT THSERT IHSERT IHEERT

B.68dE
MT &

In this window you can view and edit the parameters of MATRIX channels 1-8. The parameters shown in the window can
be selected from the [View] menu or the menu that appears when you right-click (<control> key + click) in the window.

You can access this window in the following ways.
o From the [Windows] menu, choose [Overview] and then choose “MATRIX”
o Use the bank select keys in the Main window to turn on the [MTRX] button

O MIX/CH/ST IN (Send levels from the MIX/INPUT CH/ST IN to
the MATRIX bus)

This switches between indicating the sends from MIX channels 1-24, the sends from
INPUT CH 1-16/17-32/33-48/49-64 (CL3), 49-72 (CL5), and the sends from ST IN.

il i CHi-1& STIN1-5

0 =1 O R D R —

NG R | -

1
1
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1
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The bar graphs located immediately below the button indicate/adjust the level of the signal
that is sent from each channel to the MATRIX bus. The method of operation and the mean-
ing of the display are the same as for ((®)) MATRIX in the MIX window (= p.24.)

26 CL Editor Owner’s Manual



(@ STEREO (Send levels from the STEREO channels to the MATRIX
STERED bus)
Here you can view and edit the send levels of the signals sent from the STEREO channels to
the MATRIX bus. While you drag the bar graph, the send level is shown in the numerical

display area immediately below. The method of operation and the meaning of the display
are the same as for ((5)) MATRIX in the MIX window (w» p.24.)

® EQ (Equalizer)
Switches the EQ on/off. The graph immediately below the button shows the approximate

response of the EQ. This is the same as the equalizer for INPUT CH (= p.18.)

(® DYNA1 (Dynamics 1)
Switches the dynamics processor on/off. This is the same as the dynamics 2 for INPUT CH
(= p.18.)

&) INSERT

Enables/disables the insert-in.

(® SEL (Channel selection)
Selects the MATRIX channel for which you want to make settings.

(D CUE
This button cue-monitors the signal of the MATRIX channel.
In the ONLINE state, if MATRIX bus channels 7 and 8 can be used as a second cue, the
indication shows “CUE A,” “CUE B,” or “CUE AB” depending on the settings of the
console.

If the Channel Select/Sends On Fader checkbox in the System Setup dia-
log box is not checked, the [CUE] button will be hidden in the screen.

ci— B ON
U= i This switches the MATRIX channel on/off.
If the corresponding channel is off, the fader will be grayed out.

(@ Fader

This adjusts the output level of the MATRIX channel. The current fader value is shown in
the numeric box immediately below the fader.
The numbers and alphabetical letters at the right of the fader indicate the DCA group and
mute groups to which that channel belongs, and show the Recall Safe and Mute Safe status
of the channel. (For the significance of the numbers and alphabetical letters, see = p.24.)
e Click the indicator area at the right side of the fader to switch between 3
indicators (mute group indicator, DCA group indicator, level meter).
e While holding down the <Ctrl> (<& >) key of your computer keyboard, drag
& drop the area around the fader to copy the channel (CH COPY).

Channel number
Indicates the number of the MATRIX channel. You can double-click this number to open
the Selected Channel window for this channel. If you hold down the <Ctrl>(< 3 >) key of
your computer keyboard and double-click this, the Selected Channel window will open as
an additional view.

A, BEdE
MT 1

i) Channel name
This is a text box that displays the channel name. You can also edit the channel name in this
text box. You can right-click (<control> key + click) the text box to select a channel color.
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STEREO/MONO window

ST/MONO

[HA 1 [iHa 1
INSERT IHSERT

HATRL:

Center

SEL SEL

#.6AE
5T L

In this window you can view and edit the parameters of the STEREO and MONO channels. The parameters shown in the
window can be selected from the [View] menu or the menu that appears when you right-click (<control> key + click) in
the window.

You can access this window in the following ways.
o From the [Windows] menu, choose [Overview] and then choose “STEREO/MONO”
o Use the bank select keys in the Main window to turn on the [ST] button

1 EQ (Equalizer)
Switches the EQ on/off (the L/R settings are linked.) This is the same as the equalizer for
INPUT CH (= p.18.)

(@ DYNA1 (Dynamics 1)
Switches the dynamics processor on/off. This is the same as the dynamics 2 for INPUT CH
(= p.18.)

(3 INSERT
Enables/disables the insert-in. (The L/R settings are linked.)

(® MATRIX (MATRIX SEND)
Here you can view and edit the send levels of the signals sent from the STEREO/MONO
channel to MATRIX 1-8 bus. The method of operation and the meaning of the display are
the same as for MATRIX in the MIX window (= p.24.)
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(5) BALANCE
Adjusts the left/right balance of the STEREO channel.
For MONO channels, this control indicates the send level to the MATRIX bus.

(® SEL (Channel selection)
Selects the channel for which you want to make settings. (You can specify L and R indepen-
dently.)

(@ CUE
This button cue-monitors the signal of the STEREO/MONO channel.
In the ONLINE state, if MATRIX bus channels 7 and 8 can be used as a second cue, the
indication shows “CUE A,” “CUE B,” or “CUE AB” depending on the settings of the
console.

If the Channel Select/Sends On Fader checkbox in the System Setup dia-
log box is not checked, the [CUE] button will be hidden in the screen.

ON
This switches the STEREO/MONO channel on/off.

The button is color-coded and indicates status as follows:

White: STEREO/MONO channel is on (normal mode.)
Black: STEREO/MONO channel/Send is off.
Other colors: Send is on (SENDS ON FADER mode.)

(@ Fader

Adjusts the output level of the STEREO/MONO channel.
The current fader value is shown in the numeric box immediately below the fader.
The numbers and alphabetical letters at the right of the fader indicate the DCA group and
mute groups to which that channel belongs, and show the Recall Safe and Mute Safe status
of the channel. (For the significance of the numbers and alphabetical letters, see = p.24.)
e Click the indicator area at the right side of the fader to switch between 3
indicators (mute group indicator, DCA group indicator, level meter).

e While holding down the <Ctrl> (<3 >) key of your computer keyboard, drag
& drop the area around the fader to copy the channel (CH COPY).

The fader is color-coded and indicates status as follows:

Red or Yellow: You can adjust the input level of the STEREO/MONO channel (normal
mode.)

Gray: STEREO/MONO channel is off.
Other colors: You can adjust the send level (SENDS ON FADER mode.)

Channel number

This is the channel number (ST or M.) You can double-click this number to open the
Selected Channel window for this channel. If you hold down the <Ctrl>(< 3 >) key of your
computer keyboard and double-click this, the Selected Channel window will open as an
additional view.

@ Channel name
This is a text box that displays the channel name. You can also edit the channel name in this
text box. You can right-click (<control> key + click) the text box to select a channel color.

29 CL Editor Owner’s Manual



DCA window
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In this window you can view and edit the parameters of DCA (Digital-Controlled Amplifier) groups 1-16.

You can access this window in the following ways.
o From the [Windows] menu, choose [Overview] and then choose “DCA”
o Use the bank select keys in the Main window to turn on the [DCA] button

A.8adE
OCA 1

(1) CUE
This button cue-monitors all channels that are assigned to the DCA group.
In the ONLINE state, if MATRIX bus channels 7 and 8 can be used as a second cue, the
indication shows “CUE A,” “CUE B,” or “CUE AB” depending on the settings of the
console.

If the Channel Select/Sends On Fader checkbox in the System Setup dia-
log box is not checked, the [CUE] button will be hidden in the screen.

@ON
If you turn this button off, no signal will be output from the channels assigned to the DCA
group. If you turn this button on, that status will be cancelled.

(3 DCA fader
This fader adjusts the level of the DCA group.
The current fader value is shown in the numeric box immediately below the fader.
You can set this to the minimum value (-eo dB) by holding down the <Ctrl>(< $ >) key of
your computer keyboard and clicking the fader knob, or set it to the nominal value
(0.00 dB) by holding down the <Ctrl>(< 8 >) key and <Shift> key and clicking the fader
knob. If the fader is at nominal level, the green indicator at the right of the fader will light.
If a DCA group is set to Recall Safe, the R character at the lower right of the fader is dis-
played in green.

(4 DCA number
This is the number of the DCA group.

(5 DCA group name
This is a text box that displays the DCA group name. You can also edit the DCA group name
in this text box. You can right-click (<control> key + click) the text box to select a channel
color.

(® Level Meter
This level meter indicates the post-meter of DCA.

Click the level meter area to switch between the recall-safe indicator and
the level meter.
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Selected Channel window

Here you can set the parameters of the currently selected input channel INPUT CH 1-72(*), ST IN channels 1-8) or out-
put channel (MIX channels 1-24, MATRIX channels 1-8, STEREO/MONO channels.)
You can access this window in the following ways.

o From the [Windows] menu, choose [Selected Channel] and select “Main View”

o Double-click the channel number, EQ, DYNA1, or DYNA2 button in one of the Overview windows.

By choosing [Selected Channel] from the [Windows] menu and then selecting “Additional View,” you
can view a window for a channel that is not selected. This Additional View is not linked with [SEL] button
operations on the panel of the CL.

The type of parameters that can be edited in this window depends on the type of the currently selected channel. The
parameters of the Selected Channel window are explained below, in the order of input channels (input channels 1-72(*),
ST IN channels 1-8), or output channels (MIX channels 1-24, MATRIX channels 1-8, and STEREO/MONO channels.)

(*) CL3: 1-64, CL1: 1-48

If an input channel is selected

® INPUT CH window

Selected Channel EI@

CHANNEL ————— FIBRARY ). GAIN BATE —— [ LIBRARY
3 H VT
FATCH o i
DANTET o | =

JJ
ST/ MOHD

P
s .

3. HIGH-MID

POINT
NONE FRE HFF
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® ST IN channel window
Selected Channel EI@

CHANNEL —— [IERARY

SELECT

= STINIL

ALANCE
EALAHCE
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Unless otherwise specified, the parameters explained below are common to INPUT CH 1-72 (CL3: 1-64,
CL1: 1-48) and ST IN channels 1-8.

(ACHANNEL SELECT (Channel selection)

CHAMMNEL ———————— [ LIERARY

SELECT =

Fi

= STINIL + |  LR-mon0 SELECT
RHiL STERED

(1) SELECT (Channel selection)

Indicates the number and name of the channel you are editing. To switch channels, you can either click the [SELECT]
button and choose from the list that appears, or you can click the plus/minus (+/-) channel select buttons on the left or
right side of the icon. You can right-click (<control> key + click) the icon and select the desired choice. If you left-click
the icon, you can select the channel color. You can also edit the channel name in the text box.

(@ LIBRARY
Accesses the Input Channel Library. Click this button to open the INPUT CH page of the Library window.

(® PATCH (Input patch)

Selects the input source assigned to the input channel (for the selectable input sources, = p.17.)

(9 LR-MONO SELECT (ST IN channel only)
Enables you to select STEREO, L-MONO, R-MONO, or LR-MONO for ST IN channel mode.
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ATO MIX/TO MATRIX SEND

TO MATRIX

(1) MIX/MATRIX send level
This adjusts the send level of the signal sent from the input channel to VARI-type MIX bus and MATRIX bus. The cur-
rent value is shown in the numerical box immediately below.

@ PRE (PRE on/off)
This selects PRE or POST as the point from which the signal is sent from the input channel to the MIX bus and
MATRIX bus. The point will be PRE EQ or PRE FADER when this is on, and POST FADER when this is off. The PRE
EQ/FADER setting can be specified in the Mixer Setup dialog box.

You can right-click (<control> key + click) the PRE button to display a context-sensitive menu that will
enable you to specify ALL PRE, ALL POST, or other options.

® ON (MIX/MATRIX send on/off)
This is an on/off switch for the signal sent from the input channel to the MIX bus and MATRIX bus.

e When MIX buses or MATRIX
buses are being used in stereo,
the odd-numbered knob will be
PAN or BAL (BALANCE.) If the
INPUT CH is selected, the oda- Knob of odd-numbered side Knob of odd-numbered side
numbered knob will be always
PAN. Ifthe ST IN is selected, the odd-numbered will be PAN or BAL.

You can switch between Pan and Balance in the TO STEREO/MONO section.

e [fthe FIXED type is selected for the MIX bus, only the ON button is valid.

e The stereo/mono setting and the VARI type/FIXED type setting can be
made in the Mixer Setup dialog box.

@ Channel name
This section indicates the name of the MIX channel or MATRIX channel.

Surround mode indicator
In Surround mode (= p.3), the Send indication for MIX buses 1-6 will be switched to the Surround mode parameters.

1 (@ Surround bus On/Off
These are on/off switches for signals sent from the input channel to
each Surround bus (L, C, R, Ls, LFE, or Rs).

@L/R
Adjusts the left and right surround positioning of the input channel sig-
nal. The current value is indicated in the numerical box directly below
this section.

@F/R
Adjusts the front and rear surround positioning of the input channel

signal. The current value is indicated in the numerical box directly
below this section.

@ Grid
Indicates the surround positioning of the input channel signal. The
current positioning is indicated by a dot & (red for hard panning, and
orange for other pan positions). You can also drag your mouse to move
the dot and adjust the positioning.
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(5 DIV (Divergence)
Adjusts the ratio of center-position signals distributed to the left, right and center channels. The current value is indi-
cated in the numerical box directly below this section.

(® LFE (Low Frequency Effect)
Adjusts the level of signals sent from the input channel to the LFE bus for the subwoofer. The current value is indicated
in the numerical box directly below this section.

Indication when using CUE B

In the ONLINE state, if MATRIX bus channels 7 and 8 can be used as a second cue, the MATRIX 7 and 8 send indication
will change to indicate that it is being used as CUE B.

(AHA/D.GAIN/HPF/9/GC

(D HA (HA analog gain)

Adjusts the analog gain of the internal head amp or of the external

D.GAIN — head amp patched to the input channel. The current value is shown
c in the numerical box below the knob. You can set this to the default
value (- 6dB) by holding down the <Ctrl>(< & >) key and clicking
Lk D the knob. You can also use the [48V] button to switch phantom

[. GAIM
" power on/off.

-

Wireless device indication

If a wireless digital system receiver is connected and patched to an input port as a I/O device, the head amp indication
changes to a wireless device indication.

Gain level

RF level
Battery status

Mute status

Channel name

617 SHEMHz Frequency

Indication of a device that does not feature Dante outputs

If you connect a device that does not feature Dante outputs, such as Shure AXT400, QLXD4, or ULXD4, and patch it to
an input port, the head amp indication will change.

This indication varies depending on the type of the patched device.

(Example) Indication if Shure AXT400 is patched
When the receiver is on and connected via a ShowLink® remote control

HA

ni A
e

-6dB “TX.GAIN” is displayed.

TX.GAIN M

The RF level is shown for two channels (A and B).

CH NAME. ..
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When the receiver is on and not connected via a ShowLink® remote control

A

TX.GAIN M

CH NAME. ..

When the receiver is off

TX.GAIN
CH NAME. ..

@ D.GAIN (Digital Gain)
Drag the knob in the screen to adjust the digital gain (input gain) of the input channel.

(® HPF (High Pass Filter)
Use the [ON] button at the right to switch the high-pass filter on/off. You can use the knob at left to adjust the cutoff
frequency. The current value is shown in the numerical box below the knob. An indication of “H” will appear on the
EQ graph of the equalizer.

(4 GC (Gain Compensation)

This is an on/off switch for the head amp’s analog gain correction. If you want to share the same I/O rack with the mul-
tiple CL consoles, this function maintains the audio signal at a specific level throughout the network. This button will
be displayed only if the DANTE ports have been patched.

(5) A.GAIN-D.GAIN Link

If GC (Gain Compensation) is on, this turns on or off the function that links the digital gain to the analog gain operation.

® @ (Phase)

Inverts the phase polarity of the signal after AD conversion.

(@ HPF Type
Switches the attenuation (per octave) of the high pass filter between —12dB/oct and -6dB/oct.

(Example) Indication of signal quality meter

Signal quality meter
Displays the quality of the received RF signal. The vertical axis represents quality, and the horizontal axis represents
time. The meter indicates the condition of the connection. It is refreshed once per second. The height of the meter bar
graph will be reduced if the RF signal quality deteriorates due to movement away from the transmitter or radio wave
interference.
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(ATO STEREO/MONO

Here you can specify how the signal will be sent from the input channel to the STEREO bus/MONO bus.
MODE

e ST/MONO button
When this button is on, the signal will be sent to the STEREO L/R bus and independently to the MONO bus.

TO STEREO .

O ODE M
ST, KOHO ST MOHO ST/ HOHO
PAN / BALAMNCE PAN / BALANCE
EALAHCE

PéH EALAMCE
T

Center

[INPUT CH 1-72] [ST IN channel 1-8]

The PAN knob adjusts the panning of the signal sent from the input channel to the STE-
REO bus L/R channels. You can set this to the center position by holding down the

PAN <Ctrl>(< # >) key of the computer keyboard and clicking the knob. You can select Pan or
(PAN/BALANCE for ST IN) | Balance for ST IN. The BALANCE knob adjusts the balance of the signal that is sent from
the ST IN channel to the STEREO bus L/R channels. PAN/BALANCE can be switched
with the [PAN]/[BALANCE] buttons.

ST Switches the signal sent from the input channel to the STEREO bus on/off.

M(C) Switches the signal sent from the input channel to the MONO bus on/off.

* LCR button
When this button is on, the signal will be sent to the L/C/R buses which work in conjunction with each other.

MODE MODE
LLCE LCE

PAN / BALANCE PAN / BALANCE

E4LANCE
Féh CER EALAHCE CER

p CER ,| ‘L' rL

Center Sh% Center 1ok Center

[INPUT CH 1-72] [ST IN channel 1-8]

The PAN knob adjusts the panning of the signal that is sent from the input channel to each
of the L/C/R channels. You can set this to the center position by holding down the

PAN <Ctrl>(< ¥ >) key of the computer keyboard and clicking the knob. You can select Pan or
(PAN/BALANCE for ST IN) | Balance for ST IN. The BALANCE knob adjusts the balance of the signal that is sent from
the ST IN channel to the STEREO bus L/R channels. PAN/BALANCE can be switched
with the [PAN]/[BALANCE] buttons.

Adjusts the proportion of the CENTER channel level relative to the STEREO bus L/R in a
range of 0—100%.

CSR (Center Side Ratio)
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JEQ (EQUALIZER)
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@ TYPE
Selects PRECISE, AGGRESSIVE, SMOOTH, or LEGACY as the EQ type.

(@ LIBRARY
Accesses the INPUT EQ page of the Library window.

(® ON

Switches the EQ (Parametric Equalizer) on/off of the currently selected channel.

@EQ graph
Indicates the response for the EQ of the currently selected channel. To reset the EQ to flat response, hold down the
<Ctrl>(< #>) key of your computer keyboard and click the graph (The HPF setting will remain.)

®Q

These knobs adjust the Q level of the frequency range selected in the EQ graph.

® FREQ (FREQUENCY)
These knobs adjust the center frequency for the four bands LOW, LO-MID, HI-MID, and HIGH.

(@ GAIN
These knobs adjust the Q, center frequency, and boost/cut amount for the four bands LOW, LO-MID, HI-MID, and
HIGH.

BYPASS
These buttons turn bypass on/off for the parameters (Q/Freq/Gain) of each band.

© [<] HIGH shelving
If this button is on, the HIGH EQ will be switched to a shelving type. If the EQ type is PRECISE, the Q knob of HIGH
EQ adjusts the Q value of the shelving type EQ. For other EQ types, the Q knob of the HIGH EQ is not shown.

LPF (Low Pass Filter)
If this button is on, the HIGH EQ will function as a low pass filter. The Q knob of the HIGH EQ is not displayed, and
the GAIN knob acts as the low pass filter on/off switch.
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@ [>] LOW shelving
If this button is on, the LOW EQ will be switched to a shelving type. If the EQ type is PRECISE, the Q knob of LOW EQ
adjusts the Q value of the shelving type EQ. For other EQ types, the Q knob of the LOW EQ is not shown.

@TYPEI/TYPE I
If the EQ type is LEGACY, you can choose one of two types: TYPEI or TYPE II.

@3 ATT (Attenuation)

Adjusts the amount of attenuation for the signal level of pre EQ.

(ADYNAMICS1/2

You can select one of the following types for each of the two dynamics processors.

DYNAMICS1 GATE, DUCKING, COMPRESSOR, EXPANDER
DYNAMICS2 COMPRESSOR, COMPANDER-H, COMPANDER-S, DE-ESSER

If GATE/DUCKING is selected
@

DYNAMICS

+15 -
0 EL: r 3 # =

_on ) 3 cedB  -SEd4E  3AYms=
L ] & nESH RAMGE DECHY

40

-]
o a1 Am=
Sl ATTACK

KEY IN

SOURCE
SELF POST ER

@) @ @5
@ TYPE

Indicates the type of the currently selected gate/ducking. You can click here to select the type. Ducking is the effect that
activates compressor triggered by another sound source.

@ LIBRARY
This button accesses the dynamics library. Clicking this button will open the DYNAMICS page of the Library window.

@ ON
This button switches on/off for the gate or the ducking.

(9 Response curve
Indicates the response for the gate/ducking of the currently selected channel.

(5) GR meter (Gain Reduction meter)
This meter indicates the amount of gain reduction produced by the gate/ducking.

(® THRESH (Threshold level)

Specifies the level (the threshold level) at which the gate/ducking will activate. The gate will open (or the ducking will
activate) when the key-in signal exceeds this level, and the gate will close (or the ducking will deactivate) when the sig-
nal falls below this level.

(D RANGE

Specifies the amount by which the signal is attenuated while the gate is closed (or while the ducking is activated.)
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DECAY

Specifies the time over which the gate will close (or the time to return to normal signal gain of ducking) after the hold
time has elapsed.

@ ATTACK

Specifies the time from when the key-in signal exceeds the threshold level until the gate opens (or from when the duck-
ing has been triggered until the signal is ducked.)

HOLD
Specifies the time that the gate will remain open (or the ducking will remain activate) after the key-in signal falls below
the threshold.

() KEY IN SOURCE

Click this to select one of the following signals to use as the key-in source.

SELF PRE EQ The pre-EQ signal of the currently selected input channel

SELF POST EQ The post-EQ signal of the currently selected input channel

MIX OUT 21—24 ;Ii'glr? output signal of the corresponding MIX channel immediately before the output attenua-

CH 1-72 POST EQ The post-EQ signal of the corresponding input channel (however, you can only choose chan-
nels belonging to the same group, within the eleven groups CH1-8, CH9-16, CH17-24,

STIN1L-STINSR POST EQ | CH25-32, CH33-40, CH41-48, CH49-56, CH57-64, CH65-72, STIN1L-STIN4R, and
STINSL-STINSR)

12 CUE
This button cue-monitors the currently selected key-in signal. This is not shown in the Additional View.
In the ONLINE state, if MATRIX bus channels 7 and 8 can be used as a second cue, the indication is fixed at “CUE A.”

If the Channel Select/Sends On Fader checkbox in the System Setup dialog box is not checked, the
[CUE] button will be hidden in the screen.

@ KEY IN FILTER

Select the type of filter applied to the selected key-in signal; HPF (high pass filter), BPF (band pass filter), or LPF (low
pass filter.) The ON/OFF button switches the filter on/off.

If you've selected BPE, use the two knobs to adjust the band pass frequency and Q. If you’ve selected HPF or LPF, use
the knob to adjust the cutoff frequency.

If COMPRESSOR/EXPANDER is selected

DYNAMICS

IH ouT
OUER

-G

-18

-
' 3 1z ABdE
B0 -an 20 . Lr  Lr A ASE GAIN
KEY IM
SOURCE
12 SELF POST EQ
®) i .. 2A.AHz
O TYPE
Indicates the currently selected compressor or expander. You can click here to select the type.
(@ LIBRARY

This button accesses the dynamics library. Clicking this button will open the DYNAMICS page of the Library window.
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(® ON

This button switches on/off for the compressor or the expander.

(9 Response curve
Indicates the response for the compressor/expander of the currently selected channel.

(5) GR meter (Gain Reduction meter)
This meter indicates the amount of gain reduction produced by the compressor/expander.

(& THRESH (Threshold level)
Specifies the threshold level at which the compressor/expander will operate. If the compressor is selected, the input sig-
nal will start being compressed when the key-in signal exceeds this level; compression will be removed when the signal
falls below this level. If the expander is selected, the input signal will start being compressed when the key-in signal falls
below this level; compression will be removed when the signal exceeds this level.

@ RATIO

If the compressor is selected, specifies the ratio at which the input signal will be compressed when the key-in signal
exceeds the threshold. If the expander is selected, specifies the ratio at which the input signal will be compressed when
the key-in signal falls below the threshold.

KNEE

Specifies the sharpness at which the output level will change. You can select from HARD or 1-5.
(© ATTACK

If the compressor is selected, specifies the time (the attack time) from when the key-in signal exceeds the threshold
level until the signal starts being compressed. If the expander is selected, specifies the time (the attack time) from when
the key-in signal falls below the threshold level until the signal starts being compressed.

GAIN

Adjusts the gain of the signal after it has passed through the compressor/expander.
1) RELEASE

If the compressor is selected, specifies the time (the release time) from when the key-in signal falls below the threshold
level until compression is removed. If the expander is selected, specifies the time (the release time) from when the key-
in signal exceeds the threshold level until compression is removed.

@ KEY IN SOURCE
Click this to select the key-in signal that you want to use.

The choices are the same as for GATE.
(3 CUE (DYNAMICS 1 only)

This button cue-monitors the currently selected key-in signal. This is not shown in the Additional View.
In the ONLINE state, if MATRIX bus channels 7 and 8 can be used as a second cue, the indication is fixed at “CUE A.”

This is not shown if the Channel Select/Sends On Fader checkbox in the System Setup dialog box is not
checked.

KEY IN FILTER (DYNAMICS 1 only)
Select the type of filter applied to the selected key-in signal; HPF (high pass filter), BPF (band pass filter), or LPF (low
pass filter.) The ON/OFF button switches the filter on/off.

If BPF is selected, the two knobs adjust the bandpass frequency and the Q. If HPF and LPF are selected, the knob
adjusts the cutoff frequency.
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If COMPANDER-H, COMPANDER-S is selected

DYMNAMICS 2 TYPE COMPANDER-H — | LIEE&REY

IH auT

GR umfr:

_ -G ]
=l 3 Rk

-1 WILTH

ccdms  AAdE a

-E0 -d0 -20 O +1& = ATTACKE EELEASE GAIM

1ms=

SELF POST ER

@ TYPE

Indicates the type of the currently selected compander (a combination of compressor and expander.) You can click here
to select the type.

(@ LIBRARY
This button accesses the dynamics library. Clicking this button will open the DYNAMICS page of the Library window.

(® ON

This button switches the compander on/off.

(9 Response curve
Indicates the response for the compander of the currently selected channel.

(5) GR meter (Gain Reduction meter)
This meter indicates the amount of gain reduction produced by the compander.

® THRESH (Threshold level)
Specifies the threshold level at which compression and expansion are applied. The input signal will be compressed
when the key-in signal exceeds this level. The expander effect will apply to levels below THRESHOLD + WIDTH.

@ RATIO

Specifies the ratio (the amount of compression.)

WIDTH
Specifies the width between the threshold level of the compressor (THRESHOLD) and the threshold level of the
expander.

@ ATTACK

Specifies the time (the attack time) until it starts to compress and expand the input signal once the compander has been
triggered.

GAIN

Adjusts the gain of the signal after it has passed through the compander.
(1) RELEASE

Specifies the time (the release time) from when the key-in signal falls below the threshold level until compression and
expansion are removed.

@ KEY IN SOURCE

Click this to select the key-in signal that you want to use.
The choices are the same as for GATE.
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If DE-ESSER is selected

DYNAMICS 2 TYP DE-ESSER — | LIERARY
IH . auT

-E0 -d0 -20 0 +1S

L II..J

SELF POST ER

O TYPE
This indicates that De-Esser is the currently selected type.

(@ LIBRARY
This button accesses the dynamics library. Clicking this button will open the DYNAMICS page of the Library window.

(® ON

This button switches the de-esser on/off.

(9 Response curve
Indicates the response for the de-esser of the currently selected channel.

(5) GR meter (Gain Reduction meter)
This meter indicates the amount of gain reduction produced by the de-esser.

® THRESH (Threshold level)

Specifies the threshold level at which the de-esser will operate. The input signal will start being compressed when the
key-in signal exceeds this level; compression will be removed when the signal falls below this level.

(D FREQ (Minimum frequency/Center frequency)
Specifies the minimum frequency (for HPF) or the center frequency (for BPF) at which the key-in signal will activate
the de-esser.

TYPE
Drag the knob in the screen to select the HPF (High Pass Filter) or BPF (Band Pass Filter.)

©®Q

Adjust the Q level of the frequency range at which the key-in signal will activate the de-esser.
This parameter is valid only if the TYPE is set to BPE

KEY IN SOURCE
The key-in signal is set to the SELF POST EQ.
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ADELAY

(D ON

Turns the delay on/off of the currently selected channel.

(@ Delay time

Drag the knob in the screen to adjust the delay time of the currently selected channel.

(JINSERT 1/2 (except for ST IN channels)

INSERT —POINT

INSERT 1
b auT

INSERT 2
ouT
SLOT3-16

(D POINT (Insert point)

Selects the position at which insert-in/out will be patched. Choose from PRE EQ, PRE FADER, or POST ON.

@ ON

Enables/disables insert-in/out.

(3® OUT (Insert out)

FRE ER -

N IH

IM
OMMIE

L na e

&, GAIM

Click this to select the output port that will be assigned to insert-out, from the following choices.

NONE

No assignment

OMNI 1-OMNI 8

OMNI OUT jacks 1-8

SLOT1-1, SLOT1-2...SLOT3-15, SLOT3-16

Output channels of an I/O card installed in slots 1-3

GEQ1L(A), GEQ1R(B)...GEQ8L(A), GEQ8R(B)

L/R inputs of GEQ rack 1-8

FX1L(A), FX1R(B)...FX8L(A), FX8R(B)

L/R inputs of EFFECT rack 1-8

PR1L(A), PR1R(B)...PRSL(A), PRSR(B)

L/R inputs of PREMIUM rack 1-8

@ IN (Insert in)

Click this to select the input port that will be assigned to insert-in, from the following choices.

NONE

No assignment

OMNI 1-OMNI 8

OMNI IN jacks 1-8

SLOT1-1, SLOT1-2...SLOT3-15, SLOT3-16

Input channels of an 1/O card installed in slots 1-3

GEQ1L(A), GEQ1R(B)...GEQSL(A), GEQSR(B)

L/R outputs of GEQ rack 1-8

FX1L(A), FX1R(B)...FX8L(A), FX8R(B)

L/R outputs of EFFECT rack 1-8

PR1L(A), PR1R(B)...PRSL(A), PRSR(B)

L/R outputs of PREMIUM rack 1-8
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® HA (HA analog gain)
Adjusts the analog gain for OMNI IN. This knob appears only if OMNI IN is patched to a head amp.

(6 48V (Phantom power)
Switches phantom power (+48V) on/off. This button appears only if the channel is patched to a head amp.

The number of available insert-ins/outs is limited. (= p.60, p.61)
If you assign more insert-ins/outs than the limitation, invalid insert-ins/outs will be grayed out. Also, the
I} indicator will appear.

(ADIRECT OUT (except for ST IN channels)

DIRECT OUT

POINT
[ = NOKE PRE HPF

A.aadE

(DO ON
Turns the direct output on/off. You can right-click (<control> key + click) the button to display a popup menu and
select ALL ON or ALL OFF.

(@ DIRECT OUT GAIN
Adjusts the gain of the direct output. The current value is shown in the numerical box below the knob. You can set this
to the nominal value (0.0 dB) by holding down the <Ctrl>(< ¥ >) key and clicking the knob.

(3 DIRECT OUT PORT

Click this to select one of the following output ports as the one used for direct out.

NONE No assignment

DANTE 1-DANTE 64 DANTE OUTPUT 1-64

OMNI 1-OMNI 8 OMNI OUT jacks 1-8

RECL, RECR L/R inputs of RECORDER

SLOT1-1, SLOT1-2...SLOT3-16 Output channels of an I/O card installed in slots 1-3

(9 DIRECT OUT POINT
Selects the position at which direct out will be patched. Choose from PRE HPE, PRE EQ, PRE FADER, or POST ON.

(ARECALL SAFE/MUTE SAFE

These enable/disable Recall Safe and Mute Safe for the channel.

RECALL SAFE

MUTE SAFE
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ADCA GROUP/MUTE GROUP

(0 DCA GROUP
Selects the DCA group (1-16) to which that channel belongs.

@ MUTE GROUP
Selects the mute group (1-8) to which that channel belongs.

3@ DCA/MUTE
These buttons enable/disable DCA group and Mute group for the
channel.

@

(D ON
Switches the input channel on/off.
If the corresponding channel is off, the fader will be grayed out.

@ Fader

Adjusts the input level of the input channel. A meter indicating the signal level is shown at
the right of the fader, and the current value is shown in the numerical box immediately
below. You can set this to the minimum value (-eo dB) by holding down the <Ctrl>(< & >)
key of your computer keyboard and clicking the fader knob, or set it to the nominal value
(0.00 dB) by holding down the <Ctrl>(< 38 >) key and <Shift> key and clicking the fader
knob.

®3 CUE

This button cue-monitors the signal of the input channel.

If the Channel Select/Sends On Fader checkbox in the System Setup dia-
log box is not checked, the [CUE] button will be hidden in the screen.

JdFader
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If a MIX channel is selected

Selected Channel E@

LIBRARY

P4TCH
DANTE

—FOINT [ PRE FROER -

8.88dE

MUTE SAFE

(ACHANNEL SELECT (Channel selection)

(D SELECT (Channel selection)
Except for the fact that your editing applies to a MIX channel, this is the

CHANNEI LIBRARY same as the channel selection for an input channel (= p.32.)
i @ LIBRARY
DANTE 1 Accesses the Output Channel Library. Click this button to open the

OUTPUT CH page of the Library window.
(® PATCH (Output patch)

Selects the output source assigned to the Mix channel (for the selectable
output sources, = p.23.)
If multiple patches have been made, only the first port is shown.

1) MATRIX send level
This adjusts the send level of the signal sent from the MIX channel to the MATRIX buses.

@ PRE (PRE on/off)
Select either PRE or POST as the position from which the signal is sent from the MIX
channel to the MATRIX bus. PRE EQ or PRE FADER is selected if this is on, or POST
FADER is selected if this is off. The PRE EQ/PRE FADER setting can be made in the Mixer
Setup dialog box.
You can right-click (<control> key + click) the PRE button to display a context-sen-
sitive menu that will enable you to specify ALL PRE, ALL POST, or other options.

e If you are using MATRIX buses in stereo,
the knob for the odd-numbered bus will be
PAN or BALANCE.

e The stereo/mono status can be specified in Knob of odd-numbered side
the Mixer Setup dialog box.

(3 ON (MATRIX send on/off)
This is an on/off switch for the signal sent from the MIX channel to the MATRIX bus.

@ Channel name
This section indicates the MATRIX channel name.
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(ATO STEREO/MONO
Here you can specify how the signal will be sent from the MIX channel to the STEREO bus/MONO bus.
In Surround mode (= p.3), use MIX channels 1-6 to set up a downmix.

MODE

¢ ST/MONO button
When this button is on, the signal will be sent to the STEREO bus and independently to the MONO bus.

o STERED 7 MOMNO —F— TS STEREQ / MONO
MODE MODE
ST MOHO ST/ MOHD

EALAMNCE
fly

Center

[for MONO mix channel] [for STEREO mix channel]

The PAN knob adjusts the panning of the signal sent from the MIX channel to the STE-
REO bus L/R channels. You can set this to the center position by holding down the
<Ctrl>(< ¥ >) key of the computer keyboard and clicking the knob. If the selected MIX bus
is used as a stereo bus, this will be the BALANCE. The BALANCE knob adjusts the bal-
ance of the signal that is sent from the MIX channel to the STEREO bus L/R channels.

ST Switches the signal sent from the MIX channel to the STEREO bus on/off.
M(C) Switches the signal sent from the MIX channel to the MONO bus on/off.

PAN (BALANCE for
STEREO bus)

e LCR button

When this button is on, the signal will be sent to the L/C/R buses which work in conjunction with each other.

T STEREDQ / MOMNO ———— TD STEREDQ 7 MOMNO
MODE MODE

BaLA&AHCE
fl:

Center

[for MONO mix channel] [for STEREO mix channel]

The PAN knob adjusts the panning of the signal that is sent from the MIX channel to each
of the L/C/R channels. You can set this to the center position by holding down the
<Ctrl>(< 3 >) key of the computer keyboard and clicking the knob. If the selected MIX bus
is used as a stereo bus, the panning will be fixed to L63 on the odd channel and to R63 on
the even channel. If the selected MIX bus is used as a stereo bus, this will be the BAL-
ANCE. The BALANCE knob adjusts the balance of the signal that is sent from the MIX
channel to the STEREO bus L/R channels.

Adjusts the proportion of the CENTER channel level relative to the STEREO bus L/R in a
range of 0-100%.

PAN (BALANCE for
STEREO bus)

CSR (Center Side Ratio)

¢ Surround mode indicator (only for MIX channels 1-6)

TO STEREQ / MONQ —mMmM : . _
LEVEL fLiJcSin:re LEVEL knob to adjust the downmix coef

This is an on/off switch for signals sent from the
L MIX channel to the L channel of the STEREO

LEVEL bus.

This is an on/off switch for signals sent from the
0 R R MIX channel to the R channel of the STEREO
bus.

f.088dE
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(JEQ (Equalizer)
@ @

LEGACY — | LIERARY H

10k 20k

FRER GAIM

© Qe

iR |
18.8kHz  @.ade
4. HIGH-MID
- |

-
4A6kHz  @AAade
2 LOW-MID
F |
)
1.88kHz  @.ade
1 LOW

- 7l
>

123Hz  8.8de

atT— Q) i4)

A.a4E

@ TYPE
Selects PRECISE, AGGRESSIVE, SMOOTH, or LEGACY as the EQ type.

(@ LIBRARY
Accesses the OUTPUT EQ page of the Library window.

(3O ON
Switches the EQ on/off.

@EQ graph
Indicates the response for the EQ of the currently selected channel. To reset the EQ to flat response, hold down the
<Ctrl>(< & >) key of your computer keyboard and click the graph.

®Q

These knobs adjust the Q level of the frequency range selected in the EQ graph.

(® FREQ (FREQUENCY)
These knobs adjust the center frequency for the four bands LOW, LO-MID, HI-MID, and HIGH.

@ GAIN
These knobs adjust the Q, center frequency, and boost/cut amount for the four bands LOW, LO-MID, HI-MID, and
HIGH.

BYPASS
These buttons turn bypass on/off for the parameters (Q/Freq/Gain) of each band.

@[] HIGH shelving
If this button is on, the HIGH EQ will be switched to a shelving type. If the EQ type is PRECISE, the Q knob of HIGH
EQ adjusts the Q value of the shelving type EQ. For other EQ types, the Q knob of the HIGH EQ is not shown.

LPF (Low Pass Filter)
If this button is on, the HIGH EQ will function as a low pass filter. The Q knob of the HIGH EQ is not displayed, and
the GAIN knob acts as the low pass filter on/off switch.
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@ [>] LOW shelving
If this button is on, the LOW EQ will be switched to a shelving type. If the EQ type is PRECISE, the Q knob of LOW EQ
adjusts the Q value of the shelving type EQ. For other EQ types, the Q knob of the LOW EQ is not shown.

@ [~] HPF (High Pass Filter)
If this button is on, the LOW EQ will function as a high pass filter EQ. The Q knob of the LOW EQ is not displayed,
and the GAIN knob acts as the high pass filter on/off switch.

@ TYPE I/TYPE 1l
If the EQ type is LEGACY, you can choose one of two types: TYPE I or TYPEII.

ATT (Attenuation)

Adjusts the amount of attenuation for the signal level of pre EQ.

ADYNAMICS1

Except for the fact that the available types are COMPRESSOR, EXPANDER, COMPAND H and COMPAND §, and that
you can select more than one signal as the key-in signal, this is the same as the dynamics for input channels (= p.38.)

(JINSERT

Except for the fact that the insert ports that can be selected are different, this is the same as for the insert settings of an
input channel (= p.43.)

(ARECALL SAFE/MUTE SAFE

These are the same as the RECALL SAFE/MUTE SAFE functions for input channels (= p.44.)

ADCA GROUP/MUTE GROUP

These are the same as the DCA GROUP/MUTE GROUP functions for input channels (= p.45.)

JFader

1D ON
Switches the MIX channel on/off.

@ Fader

Adjusts the output level of the MIX channel. A meter indicating the signal level is shown at
the right of the fader, and the current value is shown in the numerical box immediately
below. You can set this to the minimum value (-e> dB) by holding down the <Ctrl>(<>)
key of your computer keyboard and clicking the fader knob, or set it to the nominal value
(0.00 dB) by holding down the <Ctrl>(< 8 >) key and <Shift> key and clicking the fader
knob.

(3 CUE
This button cue-monitors the signal of the MIX channel.
In the ONLINE state, if MATRIX bus channels 7 and 8 can be used as a second cue, the
indication shows “CUE A,” “CUE B,” or “CUE AB” depending on the settings of the console.

If the Channel Select/Sends On Fader checkbox in the System Setup dia-
log box is not checked, the [CUE] button will be hidden in the screen.
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If a MATRIX channel is selected

Selected Channel

CHANNEL ————— [IERARY

SELECT Eoer

DANTE2S

= [MATRIX1
MT 1

TO STEREQ / MONO

SELF PRE EQ

EQ-  PRECISE

POINT [PRE FADER |-

IH
NONE

3. HIGH-MID

2 LOW-MID

1LOW

8648 MUTE SAFE

(ACHANNEL SELECT (Channel selection)

Except for the fact that your editing applies to a MATRIX channel, this is the same as the channel selection for a MIX chan-

nel (= p.46.)

JFROM MIX, ST/MONO(C)

FROM MIX

Eeaty ]

@ PRE (PRE on/off)

(4 Channel name

MONO channel.

50

1 FROM MIX, ST/MONO(C) send level
These adjust the send levels of the signals sent from the MIX
buses or STEREO/MONO buses to the MATRIX bus. The cur-
rent value is shown in the numerical box immediately below.

These select either PRE or POST as the position from which the
signal is sent from the MIX buses or STEREO/MONO buses to
the MATRIX bus. PRE EQ or PRE FADER is selected if this is
on, or POST FADER is selected if this is off. The PRE EQ/
FADER setting can be made in the Mixer Setup dialog box.

(3 ON(FROM MIX, ST/MONO send on/off)
These are on/off switches for the signal sent from the MIX buses
or STEREO/MONO buses to the MATRIX bus.

This section indicates the name of the MIX channel or STEREO/
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ABALANCE

TO STEREO / MONO This is shown only if the selected MATRIX bus is being used as stereo. It
adjusts the left/right volume balance of the stereo signal. You can set this to the
center value by holding down the <Ctrl>(< 3 >) key of your computer key-
board and clicking this knob.
BALANCE

fl:

Center

(JEQ (Equalizer)

This is the same as for the equalizer of a MIX channel (= p.48.)

ADYNAMICSI1

Except for the fact that the available types are COMPRESSOR, EXPANDER, COMPAND H and COMPAND §, and that
you can select more than one signal as the key-in signal, this is the same as the dynamics for input channels (= p.38.)

(JINSERT

Except for the fact that the insert ports that can be selected are different, this is the same as for the insert settings of an
input channel (= p.43.)

(ARECALL SAFE/MUTE SAFE

These are the same as the RECALL SAFE/MUTE SAFE functions for input channels (= p.44.)

ADCA GROUP/MUTE GROUP

These are the same as the DCA GROUP/MUTE GROUP functions for input channels (= p.45.)

JFader

1D ON
This switches the MATRIX channel on/off.

@ Fader

This adjusts the output level of the MATRIX channel. A meter indicating the signal level is
shown at the right of the fader, and the current value is shown in the numerical box imme-
diately below. You can set this to the minimum value (- dB) by holding down the
<Ctrl>(< #>) key of your computer keyboard and clicking the fader knob, or set it to the
nominal value (0.00 dB) by holding down the <Ctrl>(< 3 >) key and <Shift> key and click-
ing the fader knob.

(® CUE
This button cue-monitors the signal of the MATRIX channel.
In the ONLINE state, if MATRIX bus channels 7 and 8 can be used as a second cue, the
indication shows “CUE A,” “CUE B,” or “CUE AB” depending on the settings of the console.

If the Channel Select/Sends On Fader checkbox in the System Setup dia-
log box is not checked, the [CUE] button will be hidden in the screen.
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If a STEREO/MONO channel is selected

® STEREO channel window

Selected Channel

EQ-

® MONO channel window

Selected Channel

= HONDCCY
MOND

EQ-

EALANCE

LEGRCY

PRECISE

3. HIGH-MID

SERT —FOINT | PRE FROER -

IH
NONE

a.ade

a.ade

— [ LIERARY NI

GAIN
— POINT [ PRE FRDERT -
il
>l

8.6dE

IH
HOME

666 MUT

(ACHANNEL SELECT (Channel selection)

Except for the fact that your editing applies to a STEREO/MONO channel, this is the same as the channel selection for a

MIX channel (= p.46.)

ATO MATRIX

These are the same as the TO MATRIX of a MIX channel (= p.46.)
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(ABALANCE (except for MONO channel)

This adjusts the left/right volume balance in the STEREO bus. You can set this
to the center value by holding down the <Ctrl>(< $ >) key of your computer
keyboard and clicking this knob.

TD STEREQ ¥ MOMO

BALANCE
il

Center

JEQ (Equalizer)

This is the same as the equalizer settings of a MIX channel (= p.48.)

ADYNAMICS1

Except for the fact that the available types are COMPRESSOR, EXPANDER, COMPAND H and COMPAND §, and that
you can select more than one signal as the key-in signal, this is the same as the dynamics for input channels (= p.38.)

(JINSERT

Except for the fact that the insert ports that can be selected are different, this is the same as for the insert settings of an
input channel (= p.43.)

(JRECALL SAFE/MUTE SAFE

These are the same as the RECALL SAFE/MUTE SAFE functions for input channels (= p.44.)

ADCA GROUP/MUTE GROUP

These are the same as the DCA GROUP/MUTE GROUP functions for input channels (= p.45.)

(dFader
STEREO @ ON
This switches the STEREO/MONO channel on/off.
@ Fader

Adjusts the output level of the STEREO/MONO channel. A
meter indicating the signal level is shown at the right of the
fader, and the current value is shown in the numerical box
immediately below.

(® CUE
This button cue-monitors the signal of the STEREO/MONO
channel.

In the ONLINE state, if MATRIX bus channels 7 and 8 can be

used as a second cue, the indication shows “CUE A,” “CUE B,” or
“CUE AB” depending on the settings of the console.

-1.654E If the Channel Select/Sends On Fader checkbox

in the System Setup dialog box is not checked,

the [CUE] button will be hidden in the screen.
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Library window

Library EI@

DYNAMICS

NOFILE DYNAMICS

INTERNAL DATA

TITLE [} TYPE
Gate
Ducking
A.Dr.BD
A.Dr.SN
De-Esser

N

Conp

Expand
Conpander{H}
Conpander{5)
A.Dr.BD
A.Dr.BD
A.Dr.SN
A.Dr.SN
A.Dr.SN
A.Dr.Tom
A.Dr.OverTor

NN NN

N

E.B.Finger
E.B.Slap
Svn.Bass
Pianol
Piano2

DV DVIVIVD DNV WV NDINI I IIDDDDD

RN NN

Here you can edit the CL’s various libraries. You can also load library files that were saved on a drive of your computer, edit
the order or title of library items, recall the desired library data, or copy desired library data to a library within the CL.
This window is divided into DYNAMICS, INPUT EQ, OUTPUT EQ, EFFECT, GEQ (Graphic Equalizer), 8BAND PEQ,
INPUT CH, and OUTPUT CH pages; to switch pages, click the tabs located at the top of the window.

To display this window, choose [Library] from the [Windows] menu, and select either “DYNAMICS,” “INPUT EQ,” “OUT-
PUT EQ,” “EFFECT,” “GEQ,” “8BAND PEQ,” “INPUT CH,” or “OUTPUT CH.”

Regardless of the file type of the opened file, executing SAVE or SAVE AS in this window will save only
the library data relative to the opened tab.

(1) OPEN (Open a file)
Opens a library file located on a drive of your computer. Use this when you want to edit library data that you've saved
on a USB flash drive.

(2 CLOSE (Close a file)

Closes the currently-open library file.

(® SAVE

Saves the currently-open library file on a drive of your computer. Use this to re-save an edited library on a USB flash
drive, or to create a backup on the hard disk of your computer.

(49 SAVE AS (Save under a different name)

Saves the currently-open library file under a different name on a drive of your computer.

(® File name
Indicates the file name of the currently-open library.
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@ (Effect/GEQ/8BAND PEQ page only)

No.

EFFECT

(1)) (DYNAMICS page only)

TYPE
Gate GRTE
Ducking DICKING
ADr.BD GATE
A.Dr.SN
De-Esser

M| ha

Comp
Exrand
Compander{H}

n | ha

Compander{3)
A.Dr.BD
A.Dr.BD
A.Dr.SN
A.Dr.SN
A.Dr.SN
A.Dr.Tom
A.Dr.OverTop
EB.Finser
E.B.Slap
Svn.Bass

MR R

ha ha

h | ha

Pianol

2 P b

Piano2

o s

® FILE

This list shows the contents of the data in the library file you opened using the OPEN button ((1)). The list includes the
following items.

(D No. (Number)

This column indicates the number of each item in the library.

TITLE

This column indicates the title assigned to each library item. You can also double-click this area and edit the title.

@R (READ ONLY)

Read-only data is indicated by an “R” in this column. It cannot be overwritten, nor can its title be edited.

TYPE

This column indicates the effect type.

In the case of dynamics, there is also an indication of the dynamics processor(s) of this channel into which each library
item can be recalled. Only library items with an indication of “1” can be recalled to DYNAMICS 1, and only library
items with an indication of “2” can be recalled to DYNAMICS 2. Library items with neither of these indications cannot
be recalled to this channel.

@ DYNAMICS (DYNAMICS page only)

Select which of the two dynamics processors will be subject to the Store or Recall operation.

@ RACK No. (Rack selection) (Effect/GEQ/8BAND PEQ page only)
Select which rack will be subject to the Store or Recall operation. In the EFFECT library, it indicates the rack number 1-
8 of the EFFECT rack. In the GEQ library, it indicates the rack number 1-16 of the GEQ and the rack number 1-8 of
the EFFECT rack. If you select the rack number that Flex 15 GEQ is assigned to, it displays the A/B select button. And
this A/B select button will be hidden if you select the rack number that 31 Band GEQ is assigned to. For the 8Band PEQ
library, indications will be the same as for Flex 15 GEQ of the GEQ library.

HQ Pitch and Freeze cannot be recalled to an effect module mounted in the even-numbered rack.
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@3 INTERNAL DATA
This area shows the CL’s library contents. The items displayed are the same as in the FILE list ((8)).
As desired, you can copy single or multiple data items between the FILE list and the INTERNAL DATA list, and copy or
move them to a different location within a list.
To do this, use the following methods to select the data item(s) that you want to copy or move.

e To select a single data item SR
Click the line containing the desired data item. Total Comp?

Gate
Ducking DUCKING
A.Dr.BD GATE
A.Dr.SN GATE
De-Esser DE-ESSER
* To select multiple consecutive data items T
Click the first data item to select it; then hold down the <Shift> key and Total Conp?
click the last data item. bato

Ducking DUCKING
A.Dr.BD BATE
A.Dr.SN k

De-Esser

* To select multiple non-consecutive data items
Click the first data item; then hold down the <Ctrl>(< 8 >) key and click
each of the remaining data items.

Total Comel

Total Comp2

Gate

Ducking DUCKING
A.Dr.BD BATE
A.Dr.SN BATE

When you have selected the data item(s) that you want to move or copy, drag CapReson

them to the desired location in the other list (if you’re copying between lists)
or in the same list (if you're copying/moving within the same list.)

e To copy data items (overwriting the destination)

Drag the copy-source data item(s) to the desired line in the other list or to :z:: gz:z;

another line in the same list. At this time, a P> symbol will appear at the Gate

right of the data item number. Ducking DUCKING
When you drop the data item in this state, a dialog box will appear, asking BATE

you to confirm the Save operation. If you click the OK button, the copy- i SN BATE
source data item(s) will be overwritten onto the copy-destination data 046 De-Esser DE-ESSER
items, and the copy-source data item(s) will remain unchanged. (If the

copy-source selection contains multiple data items, the data will be over-

written onto consecutive data items starting at that data item.)

e To move data items S—
Within the same list, you can move the selected data item(s) to another Total Conp?
location to rearrange the order of the data items in the list. To do this,
drag the selected data item(s) to a location between two other lines in the
same list. At this time, a >— symbol will appear between the lines.

When you release the mouse button in this state, the selected data item(s)
will move to that location, and the data item numbers will also change De-Esser
accordingly. (If the move-source selection contains multiple data items,

those data items will be inserted consecutively at the location you specify.)

You cannot copy the Initial Data of the GEQ library.
STORE

Stores the current settings to the data item that is selected in the list.

15 RECALL
Recalls the data item that is selected in the list.

CLEAR
Clears the data item(s) selected in the list.

(@ UNDO

Cancels the last-performed library recall, store, copy, or move operation.
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Premium Rack Library window

Premium Rack Library E”E‘@

MO FILE

INTERNAL DATA

Mo, TITLE R

000 | Initial Data

Here you can edit the libraries of the PREMIUM rack. You can also load library files that were saved on a drive of your
computer, edit the order or title of library items, recall the desired library data, or copy desired library data to a library
within the CL.
This window is divided into Portico5033, Portico5043, Portico5045, U76, Opt-2A, EQ-1A, DynamicEQ, Buss Comp 369,
and MBC4 pages; to switch pages, click the tabs located at the top of the window. To display this window, choose [Premium
Rack Library] from the [Windows] menu, and select either tab at the top of the window.
The operating procedure is the same as for the Library window (= p.54.)

Regardless of the file type of the opened file, executing SAVE or SAVE AS in this window will save only

the library data relative to the opened tab.
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Patch Editor window

Here you can assign the input/output port for each channel, its direct output, and its insert-in/out.

This window is divided into INPUT PATCH, OUTPUT PATCH, INPUT INSERT PATCH, OUTPUT INSERT PATCH,
DIRECT OUT PATCH, and PATCH LIST pages. To switch pages, click the tabs shown in the upper part of the window.

To display this window, choose [Patch Editor] from the [Windows] menu, and select either “INPUT PATCH,” “OUTPUT
PATCH,” “INPUT INSERT PATCH,” “OUTPUT INSERT PATCH,” “DIRECT OUT PATCH,” or “PATCH LIST.”

INPUT PATCH page

INFUT PATCH

O

TM}(D FROM AUTO SETUP

g oy DANTE IN

8121811121314 1516 1718 19 21

®®

Here you can select the input port that is assigned to the input of each input channel.

AHA INFO

Specifies whether the HA setting for the input port will be copied from the original channel when you modify the patching.
(O TAKE FROM PORT button

The HA setting will not be copied from the original channel. The HA setting for the port will remain the same, even if
patching is changed.

@ TAKE FROM CHANNEL button

The HA setting will be copied from the original channel. The HA setting for the previously-patched port will be applied
to a newly-patched port.

(JAUTO SETUP

(3 PRESET button
Initializes the patching in this page.

(49 CLEAR ALL button
Clears all patching in this page.
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OUTPUT PATCH page

Patch Editor

OUTPUT PATCH

Category

1D

Port §1|2]:z 56 1811121314 1516171

=) O]

AUTO SETUP

DANTE OUT

Here you can select the input port that is assigned to the output of each output channel.

(D CLEAR ALL
Clears all patching in this page.
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INPUT INSERT PATCH page

Patch Editer

INFUT INSERT PATCH

CH 116 17-32 | CH 3348 | CH

INSERT 2 Bi7/16 3 /16 5 /16

INSERT OUT INSERT IN
e OMNI IN

Output port selection Input port selection

Here you can assign input/output ports to the insert-in/out of each input channel. Select the output port in the left side of
the screen, and the input port in the right side of the screen.

IMSERT 1

(1) INSERT1/INSERT2
These buttons switch the display between INSERT 1 and INSERT 2.

(2 Current number of inserts
The number of inserts that are currently assigned for the group.

If you assign more inserts than the maximum available number, this number will be displayed in red, and the [}l indi-
cator will appear next to it.

eyl If you assign more inserts than the maximum available number, the excessive inserts will be invalid.
Also, the @ indicator will appear in the corresponding channel grid.

(3® Maximum available number of inserts
The maximum number of inserts that are available for the group.

There is a limitation to the sum of INSERT 1 and INSERT 2 for each channel group, as shown below. You can assign
inserts for input ports and output ports separately.

CH49-64 CH65-72

Channel group CH1-16 CH17-32 CH33-48 (CL5 and CL3 only) (CL5 only)

Maximum available

number of inserts 16 16 16 16 8
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OUTPUT INSERT PATCH page

Pateh Editar E’

QUTPUT INSERT PATCH ‘

MIX/ST MONG | MA WDU'S 0 ‘

INSERT 2 ! /38|

INSERT QUT INSERT IN
Ca ry OMNI OUT OMNI IN

4 5 &

Output port selection Input port selection

Here you can assign input/output ports to the insert-in/out of each output channel. Select the output port in the left side of
the screen, and the input port in the right side of the screen.

WDLST MONOD
INSERT 1 I S 3R

(D) INSERT1/INSERT2
These buttons switch the display between INSERT 1 and INSERT 2.

(2 Current number of inserts
The number of inserts that are currently assigned for the group.

If you assign more inserts than the maximum available number, this number will be displayed in red, and the [l indi-
cator will appear next to it.

\[exil If you assign more inserts than the maximum available number, the excessive inserts will be invalid.
Also, the i indicator will appear in the corresponding channel grid.

(3 Maximum available number of inserts
The maximum number of inserts that are available for the group.

There is a limitation to the sum of INSERT 1 and INSERT 2 for each channel group, as shown below. You can assign
inserts for input ports and output ports separately.

Channel group MIX/ST MONO MATRIX
Maximum available 30 8
number of inserts (24 in Surround mode)
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DIRECT OUTPUT PATCH page

Patch Editar

DIRECT OUT PATCH

AUTO

[E=mEem =

SETUP

Here you can select the output port that will directly output each input channel.

(D CLEAR ALL
Clears all patching in this page.
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PATCH LIST page

Patch Editor =n (=]

CSV FILE
DANTE1 OMHI i DANTE1
DANTEZ
2 DANTEZ
OMHIY i DANTEY

OMKIS DANTES
DANTEE

= DANTEH
&= DANTE 18 = DANTEW
= DANTE11 = DANTEW
= DANTE 1 = DANTELH
= DANTE1 = DANTEW
= DANTE 14 | [ = DANTEW
= DANTE = DANTEW
= DANTE = DANTEW
= DANTE1 = DANTEW
= DANTE 13 | G = DANTESA
= DRNTE

= DANTE 18 |5
= DANTE 11

= DANTE 1

= DANTE 1

= DANTE 14

= DANTE 15

= DANTE 16

= DANTE 1

= DANTE 1

= DANTE1

= DANTEEY

Here you can view and edit the input patch and output patch settings.

DANTE1 [C A C OMNI 1 DANTE1
OMHIZ2
OMHI3

OMHIY

(D Input channel number
This is the number of the input channel.

@ Input channel name
This is the name of the input channel. You can click the channel name box to edit the name in this page.

@ Input port
This shows the input port assigned to the input channel. You can click this box and choose the input port from the
popup menu that appears.

(9 Output channel number
This is the number of the output channel.

(® Output channel name
This is the name of the output channel. You can click the channel name box to edit the name in this page.

(6) Output port
This shows the output port assigned to the output channel. You can click this box, then choose or cancel the output port
from the popup menu that appears.

You can assign multiple output ports. If you assign multiple output ports, it will display the first output
port in the order of the pop-up menu.
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CSV FILE

CH1 ch 1 = [DANTE1 |CH=3

1O IMPORT
This button imports CSV files.
The basic procedure is the same as described in the setup section for CSV file import/export. (= p.6)

@ EXPORT
This button exports CSV files.
The basic procedure is the same as described in the setup section for CSV file import/export. (= p.7)
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Virtual Rack window

Here you can make settings for GEQ (Graphic Equalizer), effects, and PREMIUM rack.

This window is divided into GEQ 1-8, GEQ 9-16, EFFECT, and PREMIUM page. To switch pages, click the tabs located at
the top of the window.

GEQ 1-8/9-16 page

wirtual Rack EI

GEQ1-2

Dwgan
und Design

1N :uu'r
A E':ﬁ E

IN OuT

o 6 o °© @

1) Mount
Select a module for mounting in the rack, from the following choices.
BLANK No assignment
31BandGEQ 31-band 1-in/1-out graphic equalizer
Flex15GEQ 2-in/2-out graphic equalizer that allows any fifteen of the 31 bands to be controlled
8BandPEQ 8-band 2-in/2-out parametric equalizer
8ch Automixer 8-channel automixer (can be mounted only in rack #1)
16ch Automixer 16-channel automixer (can be mounted only in rack #1)

65 CL Editor Owner’s Manual



@ Input patch

Select the input port (s) that will be assigned to the rack, from the following choices.

NONE

No assignment

INS1 CH1-72
(1-48 on CL1, 1-64 on CL3)

Input channel 1-72 insert out 1 (1-48 on CL1, 1-64 on CL3)

Can be selected for only GEQ racks 1-8.

INS1 MIX 1-24

MIX channel 1-24 insert out 1

INS1 MTRX1-8

MATRIX channel 1-8 insert out 1

INS1 ST L, INS1 ST R, INS1 M(C)

Insert out 1 of STEREO channel L/R or the MONO channel

INS2 CH1-72
(1-48 on CL1, 1-64 on CL3)

Input channel 1-72 insert out 2 (1-48 on CL1, 1-64 on CL3)

Can be selected for only GEQ racks 1-8.

INS2 MIX 1-24

MIX channel 1-24 insert out 2

INS2 MTRX1-8

MATRIX channel 1-8 insert out 2

INS2 ST L, INS2 ST R, INS2 M(C)

Insert out 2 of STEREO channel L/R or the MONO channel

This is not shown if nothing is mounted in the rack.

(® Module graphic

This area shows a graphic and parameters for the GEQ module, PEQ module or automixer that is currently assigned to

the rack.

You cannot edit the parameters in this screen.
Double-click this to open the module editor for that rack unit.

By holding down the <Ctrl>(< 3 >) key of your computer keyboard and double-clicking this, you can open multiple
rack module editors. For these additional editors, the rack select buttons are not linked with the RACK popup window
of the CL itself.

(@ Input meter/Output meter

These indicate the level of the signals being input and output from the rack.

(5) Output patch

Select the output port(s) that will be assigned to the rack, from the following choices.

NONE

No assignment

INS1 CH1-72
(1-48 on CL1, 1-64 on CL3)

Input channel 1-72 insert in 1 (1-48 on CL1, 1-64 on CL3)

Can be selected for only GEQ racks 1-8.

INS1 MIX 1-24

MIX channel 1-24 insert in 1

INS1 MTRX1-8

MATRIX channel 1-8 insert in 1

INS1 ST L, INS1 STR, INS1 M(C)

Insert in 1 of STEREO channel L/R or the MONO channel

INS2 CH1-72
(1-48 on CL1, 1-64 on CL3)

Input channel 1-72 insert in 2 (1-48 on CL1, 1-64 on CL3)

Can be selected for only GEQ racks 1-8.

INS2 MIX 1-24

MIX channel 1-24 insert in 2

INS2 MTRX1-8

MATRIX channel 1-8 insert in 2

Insert in 2 of STEREO channel L/R or the MONO channel

INS2 ST L, INS2 ST R, INS2 M(C)

(6) ON
This switches the GEQ module or PEQ module between active and bypassed states. The GEQ module or PEQ module
is active when the ON button is lit.

(@ GEQ Link Indicator
If a GEQ LINK is active, the GEQ Link indicator will be displayed in the left side of the rack (= p.69.)
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Rack Module Editor — GEQ window

® 31BandGEQ

Rack Module Editor ==

GEQ LINK

INPUT

CHANNEL.
NOKE

OUTPUT

® Flex15GEQ

Rack Module Editor ==

GEQ

EFFECT

GEQ LINK
INPUT

QUTPUT

A CHANNEL

1] .1

® 8BandPEQ

Rack Module Editor ==

PEQ LINK

INPUT

: CHANNEL.
NONE

OUTPUT

NOTCH A

In this window you can select the insertion destination of GEQ, and edit the parameters.
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(D Rack No. (Rack selection)
Select the rack module of the GEQ rack that you want to control.

@ LIBRARY
This button accesses the GEQ library. Clicking this button will open the
GEQ page of the Library window.
For the 8Band PEQ, this button accesses the 8Band PEQ library. Click this
button to open the 8BAND PEQ page of the Library window.

(® Input patch
Click the CHANNEL field, and choose one of the following as the signal route that will be
patched to the input channel(s) of the currently selected GEQ module and PEQ module
(If the module is mounted in the GEQ rack).

NONE No assignment
INS1 CH1-72 Input channel 1-72 insert out 1 (1-48 on CL1, 1—64 on CL3)
(1-480n CL1,1-640n CL3) | . e selected for only GEQ racks 1-8.
INS1 MIX 1-24 MIX channel 1-24 insert out 1
INS1 MTRX1-8 MATRIX channel 1-8 insert out 1
EA :mgl l\SnT(-CL)’ INS1 STR, Insert out 1 of STEREO channel L/R or the MONO channel
QUTPUT
INS2 CH1-72 Input channel 1-72 insert out 2 (1-48 on CL1, 1—-64 on CL3)
(1-480n CL1,1-64 0n CL3) | 1. 16 selected for only GEQ racks 1-8.
INS2 MIX 1-24 MIX channel 1-24 insert out 2
INS2 MTRX1-8 MATRIX channel 1-8 insert out 2
INS2 STL, INS2 STR,
INS2 M(C) Insert out 2 of STEREO channel L/R or the MONO channel

The channel name is shown in the boxes immediately below.

@ Input meter
This indicates the level of the signal that is being input to the currently selected GEQ mod-
ule and PEQ module.

(5 Output patch
Click the CHANNEL field, and choose one of the following as the signal route that will be
patched to the output channel(s) of the currently selected GEQ module and PEQ module
(If the module is mounted in the GEQ rack).

NONE No assignment
Input channel 1-72 insert in 1 (1-48 on CL1, 1-64 on CL3)

INS1 CH1-72

(1-48 on CL1, 1-64 on CL3) Can be selected for only GEQ racks 1-8.

INS1 MIX 1-24 MIX channel 1-24 insert in 1

INS1 MTRX1-8 MATRIX channel 1-8 insert in 1

INS1 STL,INS1STR, .

INS1 M(C) Insert in 1 of STEREO channel L/R or the MONO channel

INS2 CH1-72 Input channel 1-72 insert in 2 (1-48 on CL1, 1-64 on CL3)

(1-48 on CL1, 1-64 on CL3) Can be selected for only GEQ racks 1-8.

INS2 MIX 1-24 MIX channel 1-24 insert in 2

INS2 MTRX1-8 MATRIX channel 1-8 insert in 2

INS2 STL, INS2 STR, .

INS2 M(C) Insert in 2 of STEREO channel L/R or the MONO channel

The channel name is shown in the boxes immediately below.
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(6) Output meter
This indicates the level of the signal that is being output from the currently selected GEQ module and PEQ module.

® 31BandGEQ

GEQ LINK

+28 aa aa aa : 1] aa 25 a8 a8 +4.5 +13

+4.5 -38 aa ag -2.3 BA ag ag ag ag BA +ha L]

GEQ LINK

AYAILAELE
BANDS

N E— _—

= === = *.-i_*.-l_n =
= TR ER"R

(D ON (GEQ on/off)
Switches the currently selected GEQ module on/off.

® LINK

This button links the settings of two adjacent odd-numbered/even-numbered 31BandGEQ modules, or the group A
and group B settings of a Flex]15GEQ. When you click this button, a window will ask you for confirmation. Click the
buttons for the modules you want to use as the parameter copy-source and copy-destination. If you click the RESET
BOTH button, the parameters of both modules will be reset to the default state.

(® GEQ graph
This graph shows the response of the currently selected GEQ module.

GEQ faders
These faders cut/boost the frequency bands of the GEQ module. The value of each fader is shown in the numerical box
below it. Hold down the <Ctrl>(< & >) key and click to set the value to 0.00 dB.

() EQ FLAT
This button resets all GEQ faders to the 0 dB position.

{© AVAILABLE BANDS (number of operable bands) (Flex15GEQ only)
For a Flex15GEQ, you can operate any fifteen of the thirty-one bands. This numerical display box shows the remaining
number of bands that can be operated. If you have operated fifteen bands, this number will be zero, and you won’t be
able to operate any additional bands. If you want to operate another band in this state, you’ll need to return a previ-
ously-operated band back to the 0 dB position.
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® 8BandPEQ

@ @ ©),

A.AdE
GAIH

@®A/B
Toggles between A and B of 8BandPEQ.

® TYPE
Selects PRECISE, AGGRESSIVE, SMOOTH, or LEGACY as the EQ type.

® LINK

Links the A and B settings. When you click this button, a window will ask you for confirmation. Click the buttons for
the modules you want to use as the parameter copy-source and copy-destination. If you click the RESET BOTH button,
the parameters for both modules will be reset to the default state.

(@ PEQ graph
Indicates the response of the currently-selected module. Numbers and symbols on the graph refer to the bands and fil-
ters. Drag them to change the values.

(5) ON (PEQ On/Off)
Switches the currently-selected module on or off.
(® HPF (High-Pass Filter)
Use the [ON] button next to the knob to switch the high-pass filter on or off. Use the knob to adjust the cutoft fre-

quency. The current value is indicated in the numerical box below the knob. An indication of “H” will appear on the
PEQ graph.

(@ HPF Type
Switches the attenuation per octave of the high-pass filter to -24dB/oct, -18dB/oct, ~12dB/oct, or -6dB/oct.
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®Q

Adjusts the Q value for each band. The current value is indicated in the numerical box below the knob.

(@ FREQ (Frequency)

Adjusts the center frequency for each band. The current value is indicated in the numerical box below the knob.

GAIN

Adjusts the boost/cut amount for each band. The current value is indicated in the numerical box below the knob.

@ BYPASS
These buttons turn bypass on/off for the parameters (Q, FREQ, GAIN) of each band.

@ LPF (Low-Pass Filter)
Use the [ON] button next to the knob to switch the low-pass filter on or off. Use the knob to adjust the cutoff frequency.
The current value is indicated in the numerical box below the knob. An indication of “L” will appear on the PEQ graph.

@ LPF Type
Switches the attenuation per octave for the low-pass filter to -24dB/oct, ~18dB/oct, —~12dB/oct, or —-6dB/oct.

NOTCH A, B, C (Notch filter A, B, C)
CL Editor features three notch filters.

Use the left knob to adjust the Q value. Use the right knob to adjust the center frequency. Use the [ON] button next to
the knobs to switch the notch filter on or off. The current value is indicated in the numerical box below the knob. An

» «

indication of “A”, “B”, or “C” will appear on the PEQ graph.

@ EQ FLAT
Resets all gain values to 0dB.
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Rack Module Editor—Automixer Window

Rack Medule Editor
1] [

L OVERS (FOVERS (WOVER® / -
Al
EFFECT——————— r /
meters  reset ™

Dan Dugan
Sound Design

level level level level

. avto mixx . auto mix . auto mix . auto mix
eight ™ gain  weight |~ gain  weight ™ gain — weight | ™ o5, — weight

i Sl A | | |
» 5 : B R e

-3 | -3

i 4

-12

auto mix ht auto mix ht auto mix ht
gain WEWhL | gaip  WEINL | gogn  Welgh

-15 -15 -15
group owverride group override group override group override group override group override group override group override
a a a b b b c c

preset preset preset preset preset presat preset preset
5 [ 7 8

Here you can edit the parameters for the automixer.

In situations such as an unscripted speech, the automixer automatically detects the mics that are in use and optimizes their
gain distribution. This feature maintains a consistent system gain among multiple mics without requiring an engineer to be
focused on fader operations.

(1) RACK No.
Select the rack module of the GEQ rack that you want to control. The
automixer can be mounted only in rack #1.

(@ Channel indication
For channels 1-8 and channels 9-16, this shows the auto mix gain
meter and status of each channel: man (yellow) / auto (green) / mute
(red).
When you select the channel 1-8 or channel 9-16 area, the channels
shown in the channel control field will switch between 1-8 and 9-16.

(For the 8-channel Automixer, only channels 1-8 are shown.)
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JdMaster field

a C

FOVER™
RIDE RIDE RIDE

FPRESET (PRESET PRESET

meters reset

(3 OVERRIDE / PRESET / MUTE

This setting can be made for the group (a/b/c) that is selected in the channel control field. Only the selected group is
shown.

e OVERRIDE

If OVERRIDE is turned on, the setting will switch to man mode or mute mode, depending on the override settings of
the channels in the same group.

e PRESET
Switches the channels of the same group to the mode (man/auto/mute) that has been preset.
e MUTE

Switches the channels of the same group to mute mode.

(© meters
Switches the meter indicator of the channel control field. Each time you press the button, the setting cycles among gain,
input, and output.

(B reset

Initializes the settings of the Automixer.
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(dChannel control field

® level indicator
Indicates the Automixer level.

a“;":d‘ i"":i‘: weight Lit green: Audio is at an appropriate level for the automixer.
Unlit: Lower than the appropriate level
Lit red: Higher than the appropriate level

Adjust the HA gain of the CL unit so that the indicator remains lit green.

® (@ Meter indicator

Each time you press the meters button (4) in the Master field, you'll cycle between the fol-
lowing three types of meter.

Meter display color Meter type
o) Green (gain) Automix gain
Yellow (input) Input level
Blue (output) Output level

Normally you should leave this set at automix gain.

weight
Adjusts the relative sensitivity between input channels. Adjust the weight setting so that all
of the automix gain meters are at approximately the same level when there is no input.

f @ group
You can assign each channel to one of three groups (a, b, or c).
The channel’s background color will change depending on the selected group.

override
When you press the OVERRIDE button (3) in the Master field, the corresponding channels
will switch to man mode or mute mode depending on the setting of this button.

o Ifthe channel’s override button is on, turning on the master OVERRIDE button will switch
the channel’s mode to man.

o If the channel’s override is off, turning on the master OVERRIDE button will switch the
channel’s mode to mute.

« When you turn the master OVERRIDE button off, that channel will return to its prior mode.

@) Channel number
Indicates the channel number within the automixer.

(2 Channel name
Indicates the name of the channel that is patched.

(3 man / auto / mute
Cycles among man, auto, and mute.

man: Passes the audio without changing the gain.
auto: The automixer will be on.
mute: The channel will be muted.

preset

Selects the channel’s mode (man/auto/mute) when the PRESET button (3) in the master
field has been pressed. The preset indicator will cycle among man/auto/mute each time you
press the preset button.

74 CL Editor Owner’s Manual



EFFECT page
¢

Virtual Rack @
EFFECT
[ [} _DI.IT

LFLR

I OuT

LFLR

IN OuT

LFELR

IN OUT

LFLR

IN OuT

LFLR

IN OUT

LFELR

IN OUT

LFLR

(1) Mount
Select a module for mounting in the rack, from the following choices.
BLANK No assignment
31BandGEQ 31-band 1-in/1-out graphic equalizer
Flex15GEQ 2-in/2-out graphic equalizer that allows any fifteen of the 31 bands to be controlled
EFFECT Internal effect
8BandPEQ 8-band 2-in/2-out parametric equalizer

@ Input patch
Click the L CHANNEL or R CHANNEL area, and choose one of the following as the signal route that will be patched to
the L/R input channels of the internal effect.

NONE No assignment

MIX 1-24 MIX channel 1-24

MATRIX1-8 MATRIX channel 1-8

STL, ST R, MONO(C) STEREO channel L/R, MONO channel

INS1 CH 1-72(*) INPUT channel 1-72(*) insert out 1

INS1 MIX 1-24 MIX channel 124 insert out 1

INS1 MTRX1-8 MATRIX channel 1-8 insert out 1

INS1 ST L, INS1 ST R, INS1 M(C) Insert out 1 of STEREO channel L/R or the MONO channel
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INS2 CH 1-72(*)

INPUT channel 1-72(*) insert out 2

INS2 MIX 1-24

MIX channel 1-24 insert out 2

INS2 MTRX1-8

MATRIX channel 1-8 insert out 2

INS2 ST L, INS2 ST R, INS2 M(C)

Insert out 2 of STEREO channel L/R or the MONO channel

(*) CL3: 1-64, CL1: 1-48

(® Module graphic

This area shows a graphic of the effect module, the GEQ module or the PEQ module that is currently assigned to the
rack, and the parameters of that module. You cannot edit the parameters on this page. Double-click this to open the
module editor for that rack unit. By holding down the <Ctrl>(<$>) key of your computer keyboard and double-click-
ing this, you can open multiple rack module editors. For these additional editors, the rack select buttons are not linked
with the RACK popup window of the CL itself.

(@ Input meter/Output meter

These indicate the level of the signals being input and output from the effect module, the GEQ module or the PEQ

module.

(5 Output patch

Click the L CHANNEL or R CHANNEL area, and choose one of the following as the signal route that will be patched to
the L/R output channels of the internal effect.

NONE

No assignment

CH 1-72(%)

INPUT channel 1-72(*)

STIN1L-STINSR

ST IN channel 1-8 L/R

INS1 CH 1-72(*)

INPUT channel 1-72(*) insert in 1

INS1 MIX 1-24

MIX channel 1-24 insert in 1

INS1 MTRX1-8

MATRIX channel 1-8 insert in 1

INS1 ST L, INS1 ST R, INS1 M(C)

Insert in 1 of STEREO channel L/R or the MONO channel

INS2 CH 1-72(*)

INPUT channel 1-72(*) insert in 2

INS2 MIX 1-24

MIX channel 1-24 insert in 2

INS2 MTRX1-8

MATRIX channel 1-8 insert in 2

INS2 ST L, INS2 ST R, INS2 M(C)

Insert in 2 of STEREO channel L/R or the MONO channel

(*) CL3: 1-64, CL1: 1-48

® BYPASS

This switches the effect module or the GEQ module between active and bypassed states. An effect module is active

when the BYPASS button is dark.
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Rack Module Editor — Effect window

Rack Module Editor [Locked] @@

RACK No. aEQ

EFFECT
N

EFFECT NAME Hall
HALL 1IH.

MIX BALANCE  TIME || INLOLY HLRATIO

GATE LYL|| ATTACK

L CHANKEL

i CHANMWEL
STIN4R
Rt4R

Rack Module Editor @@

GEQ— [ E5YAMAHA REV=xX HALL

Reverb Time HFF
EFFECT ————— 2 Initial Delay LPF
L1 | g Decay : Hi Ratio
EFFECT MAME FE E Room Size Low Ratio
Diffusion 5 Low Freq

MIX BALANCE HiRratio[ 85 ]
LowRatiol 121
Fik JifFusion [ 18]

. [ Thea ]
L CHANNEL 1k
100,

R CHANNEL
NOHE

- EA

QUTPUT

L CHANKEL

Here you can select the effect type for an internal effect, edit the parameters, and specify the input/output patching.
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©) @ @ @ORack No. (Rack selection)
Select the rack module of the EFFECT rack that you want to
control.

@ BYPASS
This button temporarily bypasses the effect.

(® CUE
el == Hall LIERARY This button cue-monitors the output of the currently selected
TYPE REVERE HALL 1INf20UT effect.
In the ONLINE state, if MATRIX bus channels 7 and 8 can be
used as a second cue, the indication is fixed at “CUE A” by the
settings of the console.
If the Channel Select/Sends On Fader checkbox

in the System Setup dialog box is not checked,
the [CUE] button will be hidden in the screen.

(9 EFFECT NAME
Indicates the title of the currently selected effect.

(5 TYPE (EFFECT TYPE)

Indicates the currently selected effect type. You can also switch the effect type from this window. To do so, click the text
box, and select the desired effect type from the popup menu that appears.

(6 LIBRARY
This button accesses the effect library. Clicking this button will open the EFFECT page of the Library window.

@ Input patch

INPUT Click the L CHANNEL or R CHANNEL area, and choose one of the fol-
lowing as the signal route that will be patched to the L/R input channels of
the internal effect.

,__L CHANNEL NONE No assignment
1 MIX 1-24 MIX channel 1-24
@ R CHANEL MATRIX1-8 MATRIX channel 1-8
R ST L, ST R, MONO(C) | STEREO channel L/R, MONO channel
G|_J-|:F.t;j-|— INS1 CH 1-72(*) INPUT channel 1-72(*) insert out 1
INS1 MIX 1-24 MIX channel 1-24 insert out 1
INS1 MTRX1-8 MATRIX channel 1-8 insert out 1
L CHAMMEL i INS1 STL,INS1STR, | Insert out 1 of STEREO channel L/R or the MONO
STINIL 2 INS1 M(C) channel
® F’t;LEHHHNEL : INS2 CH 1-72(*) INPUT channel 1-72(*) insert out 2
STINIR | INS2 MIX 1-24 MIX channel 1-24 insert out 2
B INS2 MTRX1-8 MATRIX channel 1-8 insert out 2
m @ INS2 STL,INS2STR, | Insert out 2 of STEREO channel L/R or the MONO
INS2 M(C) channel

(*) CL3: 1-64, CL1: 1-48
The channel name is shown in the boxes immediately below.

Input meter

Indicates the level of the signal being input to the internal effect.

(@ Output patch
Click the L CHANNEL or R CHANNEL area, and choose one of the following as the signal route that will be patched to
the L/R output channels of the internal effect.

NONE No assignment
CH 1-72(*) INPUT channel 1-72(*)
STIN1L-STIN8R ST IN channel 1-8 (L/R)
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INS1 CH 1-72(*) INPUT channel 1-72(*) insert in 1

INS1 MIX 1-24 MIX channel 124 insert in 1

INS1 MTRX1-8 MATRIX channel 1-8 insert in 1

INS1 ST L, INS1 ST R, INS1 M(C) Insert in 1 of STEREO channel L/R or the MONO channel
INS2 CH 1-72(*) INPUT channel 1-72(*) insert in 2

INS2 MIX 1-24 MIX channel 1—24 insert in 2

INS2 MTRX1-8 MATRIX channel 1-8 insert in 2

INS2 ST L, INS2 ST R, INS2 M(C) Insert in 2 of STEREO channel L/R or the MONO channel

(*) CL3: 1-64, CL1: 1-48
The channel name is shown in the boxes immediately below.

Output meter

Indicates the level of the signal being output from the internal effect.

() Parameter display select button
If “REV-X HALL,” “REV-X ROOM,” “REV-X PLATE,” or VCM effect is selected as the effect type, this button switches
between the standard parameter screen and a dedicated GUT screen.

IS (@ MIX BALANCE

Adjusts the balance of the effect sound relative to the original sound. 0 (%) outputs only the
original sound, and 100 (%) outputs only the effect sound.

i3 TEMPO
If a tempo-type or modulation-type effect is selected, this allows you to adjust time-related
parameters such as DELAY (delay time) and FREQ. (modulation speed.)
To set the value of the TEMPO parameter, you can either input the BPM (Beats Per Minute)
in the numerical box, or repeatedly click the TAP TEMPO button at the desired tempo.

If the MIDI CLK button is on, the TEMPO parameter value will synchronize to the MIDI
timing clock being received from the MIDI port.

188 BPM

SOLO
If “M.BAND DYNA” or “M.BAND COMP” are selected as the effect type, these buttons
allow you to monitor only the specified band from the three bands HIGH, MID, and LOW.

{® GR meter (Gain Reduction meter)
If “M.BAND DYNA” or “M.BAND COMP” are selected as the effect type, this indicates the
gain reduction amount for the H (HIGH), M (MID), and L (LOW) bands.
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REC MODE | | REC DLY | |PL% MODE| | TRG LYL | |TRG MASK (|| START EHD LOop

MANLAL CONTL -35dE 108Am= A.8m= [ ms A.Ams

LOOP NUM FINE MIDI TRiG [SAMPLED | | [SAMPLE] | | [SAMPLE]

PLAY/REC (Play/Record) buttons

If “FREEZE” is selected as the effect type, you can use these buttons to record and play back the signal being input to
the effect.

(@ Effect parameters

This area shows the effect parameters and knobs for the currently selected effect type. It also shows the GUI screen that
are specific to the following each effect type: REV-X HALL, REV-X ROOM, REV-X PLATE, COMP276, COMP276S,
COMP260, COMP260S, EQUALIZER601, and OPENDECK.
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PREMIUM page

Virtual Rack

MOUMNT

MOUMNT

1) Mount

Select a PREMIUM rack module (EQ or compressor) for mounting in the rack, from the following choices: BLANK,
Portico5033 (DUAL/STEREO), Portico5034 (DUAL/STEREQ), Portico5045 (STEREO/DUAL), U76 (DUAL/STE-
REO), Opt-2A (DUAL/STEREO), EQ-1A (DUAL/STEREO), DynamicEQ (DUAL/STEREO), Buss Comp 369 (DUAL/

STEREO), and MBC4 (STEREO/DUAL).

U76 (DUAL/STEREO) can be mounted only in an odd-numbered rack, and occupies two rack spaces.

@ Input patch

Click the CHANNEL field (Click L CHANNEL or R CHANNEL area for the stereo EQ or compressor), and choose one
of the following as the signal route that will be patched to the input channel(s) of the currently selected PREMIUM rack

module.
NONE No assignment
MIX 1-24 MIX channel 1-24 (only for rack 1-2)
MATRIX1-8 MATRIX channel 1-8 (only for rack 1-2)

STL, ST R, MONO(C)

STEREO channel L/R, MONO channel (only for rack 1-2)

INS1 CH 1-72(*)

INPUT channel 1-72(*) insert out 1

INS1 MIX 1-24

MIX channel 1-24 insert out 1

INS1 MTRX1-8

MATRIX channel 1-8 insert out 1

INS1 ST L, INS1 STR, INS1 M(C)

Insert out 1 of STEREO channel L/R or the MONO channel
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INS2 CH 1-72(*)

INPUT channel 1-72(*) insert out 2

INS2 MIX 1-24

MIX channel 1-24 insert out 2

INS2 MTRX1-8

MATRIX channel 1-8 insert out 2

INS2 ST L, INS2 ST R, INS2 M(C)

Insert out 2 of STEREO channel L/R or the MONO channel

(*) CL3: 1-64, CL1: 1-48

(3 Module graphic

This area shows a graphic of the PREMIUM rack module that is currently assigned to the rack, and the parameters of

that module. Double-click this to open the module editor for that rack unit. By holding down the <Ctrl>(<  >) key of
your computer keyboard and double-clicking this, you can open multiple rack module editors. For these additional edi-
tors, the rack select buttons are not linked with the RACK popup window of the CL itself.

(@ Input meter/Output meter

This indicates the level of the signal that is being input and output from the currently selected PREMIUM rack module.

(5 Output patch

Click the CHANNEL field (Click L CHANNEL or R CHANNEL area for the stereo EQ or compressor), and choose one
of the following as the signal route that will be patched to the output channel(s) of the currently selected PREMIUM

rack module.
NONE No assignment
CH 1-72(*) INPUT channel 1-72 (only for rack 1-2(*))

STIN1L-STINSR

ST IN channel 1-8 L/R (only for rack 1-2)

INS1 CH 1-72(*)

INPUT channel 1-72(*) insert in 1

INS1 MIX 1-24

MIX channel 1-24 insert in 1

INS1 MTRX1-8

MATRIX channel 1-8 insert in 1

INS1 ST L, INS1 ST R, INS1 M(C)

Insert in 1 of STEREO channel L/R or the MONO channel

INS2 CH 1-72(*)

INPUT channel 1-72(*) insert in 2

INS2 MIX 1-24

MIX channel 1-24 insert in 2

INS2 MTRX1-8

MATRIX channel 1-8 insert in 2

INS2 ST L, INS2 ST R, INS2 M(C)

Insert in 2 of STEREO channel L/R or the MONO channel

(*) CL3: 1-64, CL1: 1-48

® BYPASS

This switches the PREMIUM rack module between active and bypassed states. A PREMIUM rack module is active

when the BYPASS button is dark.
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Rack Module Editor — Premium window

Rack Module Editor

RACK. No.
[ & ]

EFFECT NAME Fo LIERARY

TYPE Fo

INPUT

CHANNEL
NONE

- BB

QUTPUT

ALL
BYPASS

5033

Portico Series
5Band Equalizer 0dB
' ’ » ' ’

*
12 ] -12d8 'dB]-12dB 'dB

'IRIM

CHANNEL
IN 3R

=l

Rack Module Editor
RACK No.

EFFECT NAME
TYPE

INPUT

L CHANMEL
NONE

R CHANMEL
NONE

- BB

QUTPUT

L

L CHANMEL
NONE

R CHANMEL
NOKWE

Here you can select the module type (EQ or compressor) for the PREMIUM rack, edit the parameters, and specify the
input/output patching. Parameter changes can be made in the specific GUI displayed on the right side of the screen for
each PREMIUM rack module. For information on the parameters of each PREMIUM rack module, please refer to the “CL’s

Reference Manual”
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RACK No.

EFFECT MAME U7: LIERARY
TYPE , UTe 5t

(1 Rack No. (Rack selection)
Select the PREMIUM rack module that you want to control.

(@ BYPASS
This button temporarily bypasses the PREMIUM rack module.

@ CUE
This button cue-monitors the output of the currently selected PREMIUM rack module.

In the ONLINE state, if MATRIX bus channels 7 and 8 can be used as a second cue, the indication is fixed at “CUE A”
by the settings of the console.

If the Channel Select/Sends On Fader checkbox in the System Setup dialog box is not checked, the
[CUE] button will be hidden in the screen.

(49 EFFECT NAME
Indicates the title of the currently selected PREMIUM rack module.

® TYPE (Module type)
Indicates the currently selected PREMIUM rack module type.

Selecting the module type is not available in the PREMIUM rack.

® LIBRARY

This button accesses the Premium rack library. Clicking this button will open the PREMIUM rack module (EQ or com-
pressor) page of the Premium Rack Library window.
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£l

QUTPUT

L CHAMWEL
INE CH1
(=

i CHAMMWEL

[

QUTPUT

R
-OVER
L CHAMWEL
INE CH1
(=
CHANKEL

2 [l

(@ Input patch

Click the CHANNEL field (Click L CHANNEL or R CHANNEL area for the
stereo EQ or compressor), and choose one of the following as the signal route
that will be patched to the input channel(s) of the currently selected PRE-

MIUM rack module.
NONE No assignment
MIX 1-24 MIX channel 1-24 (only for rack 1-2)
MATRIX1-8 MATRIX channel 1-8 (only for rack 1-2)

STL, ST R, MONO(C)

STEREO channel L/R, MONO channel (only for rack 1—
2)

INS1 CH 1-72(*)

INPUT CH 1-72(*) insert out 1

INS1 MIX 1-24

MIX channel 1—24 insert out 1

INS1 MTRX1-8

MATRIX channel 1-8 insert out 1

INS1STL, INS1STR,
INS1 M(C)

Insert out 1 of STEREO channel L/R or the MONO
channel

INS2 CH 1-72(*)

INPUT CH 1-72(*) insert out 2

INS2 MIX 1-24

MIX channel 1-24 insert out 2

INS2 MTRX1-8

MATRIX channel 1-8 insert out 2

INS2 STL, INS2STR,

INS2 M(C)

Insert out 2 of STEREO channel L/R or the MONO
channel

(*) CL3: 1-64, CL1: 1-48

The channel name is shown in the boxes immediately below.

Input meter

Indicates the level of the signal being input to the PREMIUM rack module.
When the stereo EQ or compressor has been selected, display the meter of

both the L/R.

(@ Output patch

Click the CHANNEL field (Click L CHANNEL or R CHANNEL area for the
stereo EQ or compressor), and choose one of the following as the signal route
that will be patched to the output channel(s) of the currently selected PRE-

MUIM module.
NONE No assignment
CH 1-72(*) INPUT channel 1-72 (only for rack 1-2(*))

STIN1L-STIN8R

ST IN channel 1-8 L/R (only for rack 1-2)

INS1 CH 1-72(*)

INPUT channel 1-72(*) insert in 1

INS1 MIX 1-24

MIX channel 1-24 insert in 1

INS1 MTRX1-8

MATRIX channel 1-8 insert in 1

INS1STL,INS1STR,
INS1 M(C)

Insert in 1 of STEREO channel L/R or the MONO chan-
nel

INS2 CH 1-72(*)

INPUT channel 1-72(*) insert in 2

INS2 MIX 1-24

MIX channel 1—-24 insert in 2

INS2 MTRX1-8

MATRIX channel 1-8 insert in 2

INS2 STL, INS2STR,
INS2 M(C)

Insert in 2 of STEREO channel L/R or the MONO chan-
nel

(*) CL3: 1-64, CL1: 1-48

The channel name is shown in the boxes immediately below.

Output meter

Indicates the level of the signal being output from the PREMIUM rack mod-

ule.

When the stereo EQ or compressor has been selected, display the meter of

both the L/R.
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Meter window

This window shows the signal levels of each section in the CL, letting you check for the presence of signals and whether an
overload is occurring.

This window is divided into INPUT METER and OUTPUT METER; to switch pages, click the tabs located at the top of the
window.

\[exi2 In order to view the CL’s signal levels in the Meter window, make sure that CL Editor and the CL itself are
synchronized. Also, please make sure that the Level Meter is enabled in the System Setup dialog box.

INPUT METER page

A

Meter

SE=|

INPUT METER

LEVEL METER = METERING POINT PRE DLGAIN

ol |EE

6

9 10 H 12 183 14 15 7 18 18 20 2 22 23 24 25 26 27 28 29 30 31 32

1FI2L2FI3LEH4L¢FI SFIGLEFITLTRELHR

(D) METERING POINT

Select one of the following as the point where metering will occur.
PRE G.C, PRE D.GAIN, POST D.GAIN, PRE FADER, POST ON

@ PEAK HOLD
Switches peak hold on/off.

(3 Meters

These peak level meters show the input level of each channel. The current fader value is shown in the box below.
If clipping occurs at any one of the detection points in the channel, the X segment will light.
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OUTPUT METER page

Y9 ¥

Meter

QUTPUT METER
LEVEL METER = METERING POINT FOST ON

A9 |8.60 460 666 6.00 |0.00 0.66 .68 | 0.6 |6.66 6.68 6 |6.60 0.60 | 6. 6.06 | 6.60 |0.00 |6.60

9 10 H 12 13 ¥4 15 16 7 18 19 20 20 22 23 24
M

QUER QUER OUER

-6
.00 | A.6A | 6.A7 |A.AA 6.68 |08 |A.68 | 6.6 8.6

4 5 & 7 L R MO L R C
MATRIX ————— — STEREO/MONG — — MONITOR —

(D METERING POINT

Select one of the following as the point where metering will occur.
PRE EQ, PRE FADER, POST ON

@ PEAK HOLD
This is the same as in the INPUT METER page.

(3 Meters
This is the same as in the INPUT METER page.

In Surround mode, surround bus meters will be displayed in the
MONITOR section.

In the ONLINE state, if MATRIX bus channels 7 and 8 can be used as
a second cue, both CUE A and CUE B are shown.
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Group/Link window

In this window you can select the channels that will be assigned to each DCA group and mute group. This window is

divided into four pages; the DCA GROUP ASSIGN page, the MUTE GROUP ASSIGN page, the CHANNEL LINK page
and OUTPUT CHANNEL LINK page.

DCA GROUP ASSIGN page

Group/fLink

o= ]

DCA GROUP RSSIGN
INFUT DCA

g 918 111213[14/1516/1715/19/28/21

MIX MATRIX

2 345|678

8 918 11121314/1516171819/2@ 21 d) 1
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Here you can specify the channels that will be assigned to DCA groups 1-16.

INPUT DCA

z2/al5 6|7 2l 90e 1B 1304]15)1e/17)18/1920]:

FRE &FOST

FREZPOST

FRE &FOST

MIx MATRIX ST
2|d|5|6|7/8]910/11121314/15/1&/17/18/19/20)21 2 d 2|3|d|S5|&e|?|28|L|R
FRE &FPOST

FRE &FOST

FRE &FPOST

(0 DCA group
This is the number of the DCA group.

(@ DCA group name

This is the name of the DCA group. You can also click the mouse on this area to edit the name.

(3 PRE&POST (DCA MUTE TARGET)

These buttons determine whether a Send signal routed to the bus (that features a send point set to PRE) can be muted.
Turn this button on to specify PRE and POST as the mute target. Turn this button off to specify only POST as the mute
target.

@ Grid
This grid lets you assign channels (horizontal rows) to DCA groups (vertical columns.) Currently-patched grids are
indicated by a ' symbol. To enable or disable an assignment, click the desired grid.

(5 CLEAR

These buttons clear all channels assigned to the corresponding DCA group. When you click one of these buttons a win-
dow will appear, asking you to confirm the operation. To execute the Clear operation, click the OK button.
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MUTE GROUP ASSIGN page

Group/Link EIE

MUTE GROUP fS

INPUT MUTE

MUTE
MUTEZ
MUTE3
MUTEL
MUTES
MUTEE
MUTET
MUTES

MUTE
MUTEZ
MUTE3
MUTEY
MUTES
MUTEE
MUTET
MUTES

] T 2

1 2 3 4 5 g 7 8
DIMMER LEVEL D () () ) ) ) (7 ) (7 )

-cadB -codE -cadb -codE -codb -codE -cadE -0adE

Here you can specify the channels that will be assigned to mute groups 1-8. The upper part of the screen lets you assign
input channels to mute groups, and the lower part of the screen lets you assign output channels to mute groups.

2141516 17181928 21

o0
HOTE | | |
BHEN

»

1

2 3 4 5 6 7 8
Q@ B O 6 3 6 06 O

-5A.AdE! -c0odB -cadB -cadB -73.AdE -codB -cadB -cade

(D Mute group

This area shows the mute group number.

(2 Mute group name
This area shows the mute group name. Click this area to edit the name.

(® MUTE (MUTE GROUP CONTROL)

These buttons enable/disable each input channel or output channel mute group. If the mute groups are completely
muted, they are shown in red. If the dimmer levels for those groups are set in a non-default status, they are shown in
orange.
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@ Grid
This grid lets you assign channels (horizontal rows) to mute groups (vertical columns.) Currently-patched grids are
indicated by a i} symbol. To enable or disable an assignment, click the desired grid.

(5 MUTE SAFE ON

These buttons switch Mute Safe on/off for each channel. Channels for which this button is on will be excluded from
mute groups.

® CLEAR

These buttons clear all input channels and output channels assigned to the corresponding mute group. When you click

one of these buttons a window will appear, asking you to confirm the operation. To execute the Clear operation, click
the OK button.

() DIMMER LEVEL

These knobs adjust the dimmer level for each group to lower the signal level of the group to the amount of attenuation
you set. For example, a certain amount of the monitor speaker level for a group of musicians can be lowered temporar-
ily to avoid an excessive monitor speaker level during MC in between songs.

CHANNEL LINK page

Group/Link o @)=

51

&7

3

LINKGROUP [ &
LINK PARAMETER

HPF ovHAMICS [N D
i 2
DIGITAL DIRECT MATRIR
- L m m = m

SEND PARAMETER

TO MIX

TO MATRIX
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If you link two or more input channels, the parameters of these channels will interlock with each other and change simul-
taneously.

LINK GROUP
LINK PARAMETER

CHAMICS DYHAKICS HIx MATRL=

SEHD SEHD BACES CHLO U
DIGITAL DIRECT HIA HATRIE
el e . e

SEND PARAMETER

TO MIX

TO MATRIX

@ Link buttons

Use these buttons to select the link group A-Z, a-n to which you want each input channel to be assigned. If you don’t
want an input channel to be linked, select NONE. You can assign up to forty groups (CL5: 40 groups, CL3: 36 groups,
CL1I: 28 groups) for INPUT CH 1-72 (CL3: 1-64, CL1: 1-48.)

(@ CLEAR ALL

Clears the link settings for all channels.

3 LINK GROUP button

If you select a link group using one of the corresponding Link buttons (1)), the LINK GROUP button will automati-
cally select the same link group.

(9 LINK PARAMETER

This section enables you to select the parameters to interlock.

HA Head amp gain and phantom power settings
HPF HPF settings

DIGITAL GAIN DIGITAL GAIN settings

EQ Equalizer settings

DYNAMICSH1 Dynamics 1 settings

DYNAMICS2 Dynamics 2 settings

INSERT INSERT settings

DIRECT OUT DIRECT OUT settings

MIX SEND Send amount from input channel to MIX bus
MIX ON MIX SEND on/off

MATRIX SEND Send amount from input channel to MATRIX bus
MATRIX ON MATRIX SEND on/off

FADER Fader level value

DCA DCA settings

CH ON Input channel module output on/off

MUTE Mute settings

TO ST TO ST settings

DELAY Delay settings

The HA, FADER, DIGITAL GAIN, and DELAY parameters will maintain level differences between linked channels.

(5 SEND PARAMETER

Specify the link status for each MIX/MATRIX SEND bus.
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OUTPUT CHANNEL LINK page

If you link multiple output channels, the parameters for those channels will be linked together.

LINK GROUP A
LINK PARAMETER

MATRI:
n DYHAMICS L FADER CoH ON Ta 5T
INSERT HeTRI HUTE

SEND PARAMETER

TO MATRIX

() Link buttons
Select a link group (A-P) to which the channel is assigned. If you do not plan to link the channel, select NONE.
You can assign MIX channels 1-24 and MATRIX channels 1-8 to up to 16 groups.

(@ CLEAR ALL

Clears all channel links.

(3 LINK GROUP button
When you select a link group using the LINK button, the LINK GROUP button will also select the same group.

(9 LINK PARAMETER

Selects parameters to be linked.

EQ Equalizer settings

DYNAMICS Dynamics settings

INSERT Insert settings

MATRIX SEND Send amount from output channel to MATRIX bus
MATRIX ON MATRIX send on/off

FADER Fader level value

DCA DCA settings

CH ON Input channel module output on/off

MUTE Mute on/off

TO ST TO ST settings

e The FADER parameters will maintain level differences between linked channels.
e The MATRIX SEND and MATRIX ON settings are ignored by the MATRIX channels.

(5) SEND PARAMETER
This section enables you to specify the link status for each MATRIX SEND bus.
The TO MATRIX setting is ignored by the MATRIX channels.
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Scene window

Here you can manage scene memories, and make various settings related to scene recall operations.

This window is divided into SCENE MEMORY, RECALL SAFE, FADE TIME, and FOCUS RECALL pages. To switch
pages, click the tabs shown in the upper part of the window.

Regardless of the file type of the opened file, executing SAVE or SAVE AS in this window will save only
the scene library data.

SCENE MEMORY page

Seene SEE

SCENE MEMORY

NOFILE

FILE INTERNAL DATA

3] COMMENT No. TITLE =} COMMENT

808 | Initial Data R | Initial Settina Data
801 | DEHD 1
K

Here you can edit the CL’s scene memories. You can also load scene library files from a USB flash drive or from a drive of
your computer, and edit them. In this case, you can re-save all scenes to a file after editing, recall just a desired scene, or
copy a desired scene to the scene memory of the CL itself.

(1) File name
Indicates the file name of the currently-open scene
library.

(@ OPEN (Open a file)

Opens a scene library file located on a drive of
your computer.

(3 CLOSE (Close a file)

Closes the currently-open scene library file.

@ SAVE

Saves the currently-open scene library file on a
drive of your computer.

(5 SAVE AS (Save as a different name)

Saves the currently-open scene library file under a
different name on a drive of your computer.

® FILE
This area lists the scenes in the file you opened
using the OPEN button ((2). The list includes the
following items.

To view items that are not currently
shown, scroll the list to the right.

NO FILE

COMMENT
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FOLUS A IMDIVIDUAL FADETIME

M ouT
RACK WA patce parch M OUT

(@ No.

This is the scene number in the file you opened.

TITLE

This is the scene title. You can also double-click this area and edit the title.

(® PROTECT
This indicates whether protect is on or off for each scene. This area displays a lock icon for protected scenes; these
scenes cannot be overwritten, nor their title edited. Read-only scenes are indicated by “R” displayed in this column.

You can use this protect function for read-only scenes only on the CL unit. Read-only scenes (excluding
scene No. 000) are indicated by an R symbol if the CL Editor and the CL unit are connected online.

COMMENT
This column shows the comment assigned to each scene. You can also double-click this column and edit the comment.
i FOCUS
This displays the parameters that will be recalled by scene recall.
RACK GEQ and internal effect settings will be recalled
HA Internal head amp and external head amp settings will be recalled
IN PATCH Input patch settings will be recalled
OUT PATCH Output patch settings will be recalled
IN Input channels (INPUT, ST IN, DCA) settings will be recalled except for head amp settings
OouT Output channel (MIX, MATRIX, STEREO/MONO) settings will be recalled
WITH SEND Send settings to the output channels will be recalled
DCA DCA settings will be recalled
OTHERS Other settings will be recalled

e [FOCUS] button Foaus Recl Setup SCENE 01 =
This switches the FOCUS button on/off. °

e [SET] button
(only for INTERNAL DATA list)

Click this to access the Focus Recall Setup
screen (shown at right), where you can view
the Focus function settings for each scene.

For an explanation of the contents shown, ,
refer to the FOCUS RECALL page. (= p.102) -

e FOCUS Indicator
Indicates the status of the Focus Recall set-
tings. The indicator will lit in black when all " P—
parameters are set to off.

It will lit in green when all parameters are set
to on and lit in blue when only some parame-
ters are set to on.
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@ TIME STAMP

Indicates the time at which the scene was last stored, in the format of month/day/year/hours/minutes/seconds. This
column is only for display, and cannot be edited.

i3 FADING
This switches FADING on/off for each scene.

INDIVIDUAL
This switches INDIVIDUAL mode on or off. (This mode enables you to configure the Fade function for each channel.)

15 FADE TIME
If INDIVIDUAL mode is off (i.e., in GLOBAL mode), this field indicates the FADE TIME for each scene. You can edit
the FADE TIME by double-clicking this field.

If INDIVIDUAL mode is on, this field will be empty.

INTERNAL DATA

M. TmME & coment |
No. TITLE = COMMENT

B8A  Initial Data R | Initial Setting Data
881  ScenefBl ScenefB1

BA2 SceneB2 B scenenn?
883 | SceneBB3 SceneBB3

INTERNAL DATA
This area shows the CL’s scene memory contents. The items displayed are the same as in the FILE list ((6)).

As desired, you can copy single or multiple scenes between the FILE list and the INTERNAL DATA list, and copy or
move them to a different location within a list.

@ STORE

Stores the current settings to the scene that is selected in the list.

RECALL

Recalls the settings of the scene selected in the list.

CLEAR

Clears the scene(s) selected in the list.

@ UNDO

Cancels the last-performed scene recall, store, copy, or move operation.

@ PROTECT

Turns on the Protect setting for the scene(s) selected in the list.
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RECALL SAFE page

Scene EI

RECALL SAFE

INPUT SAFE PARAMETERS QUTPUT SAFE PARAMETERS GLOBAL RECALL SAFE

GEQ RACK

EFFECT RACK

PREMIUM RACK

1
2
3
4
]
6
T
8
9

BUS SETUP

CH JOB

u L, FADER BANK SELECT

CLERR ALL - ’T ,? ’T

Here you can make settings for the Recall Safe function that excludes only specific channels from recall operations of all
scenes.

(AINPUT SAFE PARAMETERS field

In this area you can view and edit the Recall Safe settings for all input channels and ST IN channels. This area contains the
following items.

(D) SAFE ON/OFF

INPUT SAFE PARAMETERS These are on/off buttons that select the channels to be excluded
from recall operations.

(@ Parameter matrix grid
Here you can select the parameters to be excluded from recall
operations. If the ALL button is on, all parameters will be
excluded.

(® SET ALL

These buttons turn on all buttons for all input channels or ST IN
channels, or for the corresponding parameter.

(9 CLEAR ALL

These buttons turn off all buttons for all input channels or ST IN
channels, or for the corresponding parameter.

& |&|&)|6|6 6|6 I
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(JOUTPUT SAFE PARAMETERS field

In this area you can view and edit the Recall Safe settings for all output channels. The items in this area are the same as in
the INPUT SAFE PARAMETERS field.

(JGLOBAL RECALL field

In this area you can view and edit the Recall Safe parameters. These are not channel parameters, but CL global parameters
for such things as patches, DCA groups, and racks.

JUTPUT SAFE PARAMETERS GLOBAL |RECALL|SAFE
THPUT C E IHPUT
PATCH HANE

OUTPUT C - [ QUTPUT
HAKE

SAFE OMAFF

1
2
3
4
5
5]
7 B
B8
]

CH JOB

86|66 666 6s 66666 666666 6 [

= AL SET ALL =
CLEAR ALL CLEAR ALL FADER BANK SELECT

B INPUT PATCH
Excludes INPUT PATCH settings from recall operations when the button is on.

(6 CASCADE IN
If this button is on, the CASCADE IN PATCH and CASCADE IN ATT settings will be excluded from the recall target.

(@ INPUT NAME

Excludes the channel names of input channels from recall operations when the button is on.

®HA

Excludes Head Amps of I/O rack currently connected to the CL from recall operations when the button is on.

(® OUTPUT PATCH
Excludes OUTPUT PATCH settings from recall operations when the button is on.

CASCADE OUT
If this button is on, the CASCADE OUT PATCH settings will be excluded from the recall target.

i OUTPUT NAME

Excludes the channel names of output channels from recall operations when the button is on.

{ CUSTOM BANK

If this button is turned on, the custom fader banks will be excluded from the recall target.
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i3 DCA
These buttons exclude DCA groups from recall operations. If the ALL button is on, the LEVEL, ON, and DCA group
names will be excluded. If the LV/ON button is on, LEVEL and ON settings will be excluded. If the NAME button is on,
DCA group names will be excluded from recall operations.

GEQ RACK

Excludes GEQ rack settings from recall operations when the button is on.

@ EFFECT RACK

Excludes EFFECT rack settings from recall operations when the button is on.

PREMIUM RACK
Excludes PREMIUM rack settings from recall operations when the button is on.

{ BUS SETUP
Excludes BUS SETUP settings from recall operations when the button is on.

CH LINK

Excludes CH LINK settings from recall operations when the button is on.

MUTE NAME

Excludes the mute group name from recall operations when the button is on.

@ FADER BANK SELECT
If these buttons are turned on, the banks that have been selected in fader blocks A and B (or A, B, and C on the CL5) on
the top panel will be excluded from the recall target.

@) SET ALL

This button switches on all buttons for all parameters.

@ CLEAR ALL

This button switches off all buttons for all parameters.
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FADE TIME page

Scene [=[=]EE]

FADE TIME

FROING

@* EMAELE
E INDIYIDUAL

— STEREQ/MONQ —

FADE TIME

(1) FADING ENABLE

This button enables or disables the Fade function for the current scene faders.

@ INDIVIDUAL ENABLE

This button specifies whether or not the Fade function will be configured for each channel associated with the current
scene. If this function is enabled, the indication for each channel will change.

@ INPUT, ST IN, DCA

These are on/off buttons that select input channels to be excluded from recall operations.

(9 CLEAR ALL

This button switches off the buttons for all input channels.

() SET ALL

This button switches on the buttons for all input channels.

(® MIX, MATRIX, STEREO/MONO

These are on/off buttons that select output channels to be excluded from recall operations.

(D CLEAR ALL

This button switches off the buttons for all output channels.

SET ALL

This button switches on the buttons for all output channels.

(@ FADE TIME

Drag this knob on screen to adjust the fade time. The current value is shown in the numerical box immediately below.
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If INDIVIDUAL ENABLE is on

(1) CHANNEL

These are on/off buttons that select the channels to be excluded from recall operations.

@ PAN
Enables or disables the Fade function for PAN.

(® FADE TIME

Specifies the fade time for each channel. Set the time by dragging the mouse or scrolling the wheel. Alternatively, you
can double-click a value and enter a number directly.

(49 OFFSET

Specifies the amount of time from when a scene is recalled until the Fade function begins. Set the time by dragging the
mouse or scrolling the wheel. Alternatively, you can double-click a value and enter a number directly.
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FOCUS RECALL page

FOCUS

INPUT FOCUS PARAMETERS

OUTPUT FOCUS PARAMETERS

CH JOB
CH LMK HUTE HAKE

FADER BANK SELECT

e e

Here you can make focus recall settings to specify the channels and parameters that will be recalled for the currently

selected scene.

FOCUs

INPFUT FOCUS PARAMETEHR

&) |6|86)6|6|6| 6 [

AFOCUS field
() ENABLE

Enables/disables focus recall.

(JINPUT FOCUS PARAMETERS field

Here you can view and edit all of the focus recall settings for the
input channels and ST IN channels. This includes the following
items.

@ FOCUS ON/OFF

Acts as an on/off button that selects the channels that will be
recalled by scene recall.

(® Parameter matrix grid
Select the parameters that will be recalled by scene recall. If the
ALL button is on, all parameters will be recalled.

@ SET ALL

Turns on the buttons of all input channels, ST IN channels, or
the corresponding parameter.

(5 CLEAR ALL

Turns off the buttons of all input channels, ST IN channels, or
the corresponding parameter.
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(JOUTPUT FOCUS PARAMETERS field

Here you can view and edit all of the focus recall settings for the output channels. The included items are the same as for
the INPUT FOCUS PARAMETERS field.

(JFOCUS PARAMETERS field

Here you can make global focus recall settings for the entire CL console such as for patching, DCA groups, and racks (as
opposed to focus recall settings for individual channels).

OUTPUT FOCUS PARAMETERS
IHFUT CASCAD IHEUT
PATCH HiHE

QuUTPUT C JE OuTPUT
FATCH ouT H&HE

GEQ RACK
| 2al o8 3

o
o
o
o
o
or
or
o

5|5(S|6|6|6|6e)|6|6s6] |56 6|66 66666 S I

CH LIHK MUTE H&HE
T ALL

e ALEE L FADER BANK SELECT

(® INPUT PATCH

If this button is on, input patch settings will be recalled by scene recall.

(7 CASCADE IN
If this button is on, the CASCADE IN PATCH and CASCADE IN ATT settings will be specified as the recall target.

INPUT NAME

If this button is on, the channel names of input channels will be recalled by scene recall.

@HA
If this button is on, the head amps of all detected I/O racks will be recalled by scene recall.

OUTPUT PATCH

If this button is on, output patch settings will be recalled by scene recall.

i) CASCADE OUT
If this button is on, the CASCADE OUT PATCH settings will be specified as the recall target.

{© OUTPUT NAME

If this button is on, the channel names of output channels will be recalled by scene recall.
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{3 CUSTOM BANK

If this button is turned on, the custom fader banks will be included in the recall target.

DCA
These buttons specify the DCA groups that will be recalled by scene recall. If the ALL button is on, LEVEL, ON, and
DCA group names will be recalled by scene recall. If the LV/ON button is on, LEVEL and ON will be recalled by scene
recall. If the NAME button is on, DCA group names will be recalled by scene recall.

® GEQ RACK

If these buttons are on, the corresponding GEQ rack will be recalled by scene recall.

EFFECT RACK
If these buttons are on, the corresponding EFFECT rack will be recalled by scene recall.

@ PREMIUM RACK
If these buttons are on, the corresponding PREMIUM rack will be recalled by scene recall.

BUS SETUP
If these buttons are on, the corresponding BUS SETUP will be recalled by scene recall.

CH LINK

If this button is on, channel link settings will be recalled by scene recall.

@ MUTE NAME

If this button is turned on, the mute group name will be included in the recall target.

@) FADER BANK SELECT
If these buttons are turned on, the banks that have been selected in fader blocks A and B (or A, B, and C on the CL5) on
the top panel will be included in the recall target.

@ SET ALL

Turns on the buttons of all parameters.

@ CLEAR ALL

Turns off the buttons of all parameters.
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Custom Fader Bank Setup window

In this window you can make settings for the Custom Fader Bank and Main Fader. You can combine channels on the CL
unit to create individual banks for each user level. This window is divided into A, B, C (only CL5), and MAIN pages. It is
set for 8 channel faders section or 16 channels units for each A/B/C Bank.

To open the window, choose [Custom Fader Bank Setup] from [Windows] menu, and then click the “A,” “B,” “C,” or
“MAIN” tab.

@ © @ _©

Custom Fader Bank Se[tup

Custom Fader Bank Setup =]
A

CURRENT USER:  Administrator EDIT | Administrator cURRENT user:  Adninistrator L T ——

(D CURRENT USER

Displays the name of the user currently logged into the CL console. If the CL has not yet been synchronized with the
Editor, this field displays “Administrator.”

@ EDIT

Displays and enables you to specify the user level (Administrator, Guest, or Ext.User) of the Custom Fader Bank or
Main Fader that you are editing. “Ext.User” is the user who is currently logged into the CL console via a user authenti-

cation key stored on a USB flash drive or the CL console. You can select this user only when the CL console is synchro-
nized with the Editor.

6573 Ext.User’s Custom Fader Bank or Main Fader settings will not be stored in a file.
(3 CLEAR ALL

This button clears all settings of a Custom Fader Bank or Main Fader page currently opened.

(4 Fader channel

Select the fader channel you wish to assign to the Custom Fader Bank or Main Fader.
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Custom Fader Bank window

This window shows the channels of the custom fader bank setup. To open this window, choose [Custom Fader Bank] from
[Windows] menu and then choose one of the pages.

==

MATREA1 ET L MOMDCCH DCR1 MONITOR SEL Cl SEND MAIN

B Afims B Afms DANTEA

1 1

(1) Channel Patch

Click here to select the channel that will be assigned to the channel strips, from the following choices.

CH 1-72 (CL3: 1-64, CL1: 1-48) INPUT CH 1-72 (CL3: 1-64, CL1: 1-48)
STIN1L-STINSR ST IN channel 1-8 (L/R)

MIX 1-24 MIX channel 1-24

MTRX1-8 MATRIX channel 1-8

STL, ST R, MONO(C) STEREO channel L/R or MONO(C) channel
DCA 1-16 DCA channel 1-16

MONITOR MONITOR channel

STIN 1-8 ST IN channel 1-8

ST STEREO channel

CUE (In the ONLINE state, if M_ATBIX_bus_ ch_annels 7 and 8 can CUE channel

be used as a second cue, the indication is fixed at “CUE A.”)

SEL CH Selected channel

SEND MAIN SEND MAIN (in SENDS ON FADER mode)

This patch is color-coded and indicates the type of channel as follows:
Blue: Input channels, Orange: Output channels, White: Other channels.

(@ Channel Strip
Shows the channel strip that is assigned to the channel patch ((1)). This is the same as the channel strip in the Overview
window. Indicates only L or R channel for the ST IN and ST channel. You can switch between L and R by clicking the [SEL]
button.
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User Defined Keys Setup window

In this window, you can specify the functions or parameters to be assigned to the USER DEFINED keys of the CL. Opera-
tion of each parameter is done by the USER DEFINED keys of the CL. This window is divided into four (A, B, C, D) bank
pages. To switch pages, click the tabs shown in the upper part of the window.

@ ® ® @

User Defined Keys Setup EI

CURRENT USER: fAdministrator EDIT | Administrator

1  MIXONFADER 2 MATRIX ON FADER g  BODKMARK o  BODKMARK
NDRMAL NORMAL

Bl L TERNATE FUNCTION (il rose ieCEf pace crance (| poce crance

3 UNLATCH 4  TOGGLE 11 BOOKMARK BOOKMARK

@ EEE T UMl HUTE HASTER UMl HUTE HASTER

5  BOOKMARK ¢  BODKMARK 13 MUTE GROUP 1 MUTE GROLP 2

Bl poccoiovce NI pocccioe | I TaLkoac = EIED

7  BODKMARK g  DBODKMARK 15  TALKBACK ON EFFECT RACK 8
UNLATCH

To open this window, choose [User Defined Keys Setup] from [Windows] menu.

(D) CURRENT USER
Displays the name of the user currently logged into the CL console. If the CL has not yet been synchronized with the
Editor, this field displays “Administrator.”

@ EDIT

Displays and enables you to specify the user level (Administrator, Guest, or Ext.User) of the User Defined keys that you
are editing. “Ext.User” is the user who is currently logged into the CL console via a user authentication key stored on a
USB flash drive or the CL console. You can select this user only when the CL console is synchronized with the Editor.

o573 Ext.User’s User Defined key settings will not be stored in a file.

(3 Function names
Select the functions or parameters you wish to assign to the User Defined keys.
Click a User Defined key to open the Parameter List dialog box.
For more information on the assignable parameters, please refer to the CL’s manual.

(49 CLEAR ALL
Clears all settings for the USER DEFINED keys for the currently-displayed bank.
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User Defined Knobs Setup window

In this window, you can specify the functions or parameters to be assigned to the USER DEFINED knobs and Assignable
Encoder of the CL. Operation of each parameter is done by the USER DEFINED knobs and Assignable Encoder of the CL.

?

i

v

User Defined Knobs Setup

CURRENT USER: Adninistrator

User Defined Knobs

BRIGHTNESS

A LAWP

BRIGHTNESS

B PANEL

BRIGHTNESS

C  NAME

TOUCH AND TURN

EDIT  Administrator

—— Assignable Encoder

SELECTED SEND

To open this window, choose [User Defined Knobs Setup] from [Windows] menu.

(1) CURRENT USER

Displays the name of the user currently logged into the CL console. If the CL has not yet been synchronized with the
Editor, this field displays “Administrator.”

@ EDIT

Displays and enables you to specify the user level (Administrator, Guest, or Ext.User) of the User Defined knobs that
you are editing. “Ext.User” is the user who is currently logged into the CL console via a user authentication key stored
on a USB flash drive or the CL console. You can select this user only when the CL console is synchronized with the Edi-

tor.

Ext.User’s User Defined knob settings and Assignable Encoder settings will not be stored in a file.
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(3 User Defined Knobs

Select the functions or parameters you
wish to assign to the USER DEFINED
knobs of the CL. Click a User Defined
knob to open the Parameter List dia-
log box.

(@) Assignable Encoder

FUNCTION
NO ASSIGN
AUTONIXER
BRIGHTNESS
CUE
DIRECT OUT LEVEL
DYNANICS1
DYNANICSZ
EFFECT
EQ
EXTERNAL HA
HPF
170 DEVICE
INPUT DELAY
INPUT GAIN

HIDI CONTROL CHANGE

MONITOR
OSCILLATOR
DUTPUT LEVEL
OUTPUT PORT
PREMIUN RACK

PARAMETER1
ATT
LOH @
LOH FREQUENCY
LOH GAIN
LOH HID &
LOH MID FREQUENCY
LOH MID GAIN
HIGH NID &
HIGH MID FRERUENCY
HIGH MID GAIN
HIGH &
HIGH FREQUENCY
HIGH GAIN

Select the functions or parameters you wish to assign to the Assignable Encoder of
the CL. Click the Assignable Encoder knob to open the Parameter List dialog box.

PARAMETERZ
SELECTED CH
CH1
CH2
CH3
CH4
CHS
CHE
CH?

CHE
CHI

ParameterList

FUNCTION

WO ASSIGN
SELECTED SEND
HIX1 SEND
HIXZ SEND
HIX3 SEND
HIX4 SEND
HIX5 SEND
HIXG SEND
HIX7 SEND
MIXB SEND
HIX9 SEND
HIX18 SEND
MIX11 SEND
HIX12 SEND
HIX13 SEND
MIX14 SEND
HIX15 SEND
HIX16 SEND
MIX17 SEND
HIX18 SEND

e¥i3 For more information on the assignable parameters, please refer to the CL’s Manual.
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Sends On Fader window

MATRIX
MT
MT 5
MT 7

SENDS ON FADER mode enables you to adjust the send level to the MIX/MATRIX bus using the fader. In this mode, the
signals sent from all input channels to a specific MIX/MATRIX bus can be adjusted simultaneously.

Use the SENDS ON FADER button in the Sends On Fader window or Main window to switch this mode on and off.

To display this window, do one of the following:
o Select [Sends On Fader] in the [Windows] menu.
o Click the SENDS ON FADER button in the Main window.

In SENDS ON FADER mode, the color and function of the [ON] button and the fader in the Overview window will
change.

Color of the send destination | Send is on.
[ON] button

Gray Send is off.

Color of the send destination | The signal is sent to the bus.

Fader

Gray The signal is NOT sent to the bus.

Click the button (in the Sends On Fader window) for the MIX/MATRIX bus for which you want to adjust the send level.
Then switch the send level off or on, and adjust the send level using the [ON] button and fader for the input channel dis-
played in the Overview window.

e For MATRIX bus send, not only the input channels but MIX channels and STEREO/MONQO channels can be in
SENDS ON FADER mode.

e In Surround mode, the MIX bus (1-6) send will be disabled and these buttons will become inoperative.
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Outport Setup window

In the Outport Setup window you can assign the source channel for each output port and set the parameters.

Outport Setup

OANTE
1-8

DELAY SCALE

DANTE 1 DANTE 2 DANTE 3 DANTE 4 DANTE 5 DANTE & DANTE 7 ( : )
M1 M M M
W 1 M U M 5

—@
—Q
®

—®@

s 8.8d6 & 8.adE en 8.8dE & B.adE ea 8.8dE ea 8.8d8  ea 8.6dE " ea 8.0d8

1

—©
—®
—®
—®
—®

The window includes the following items.

(D Output port select tabs

These tabs switch the output ports controlled in the window in groups of up to eight ports.

(@ DELAY SCALE field
Here you can select the units for the delay time shown below the delay time knob ((8)). If the RECORDER tab is
selected for the Output port select tabs (1)), the DELAY SCALE field will be hidden in the screen.
e meter (343.59m/s)

The delay time is shown as a distance in meters, calculated as the speed of sound (343.59 m/s) at an air temperature of
20°C (68°F) multiplied by the delay time (seconds.)

o feet (1127.26ft/s)

The delay time is shown as a distance in feet, calculated as the speed of sound (1127.26 feet/s) at an air temperature of
20°C (68°F) multiplied by the delay time (seconds.)

e sample

The delay time is shown as a number of samples. If you change the sampling frequency at which the CL operates, the
number of samples will change accordingly.

* ms
The delay time is shown in units of milliseconds.

e frame
The delay time is shown as a frame rate. You can select the frame rate from the following options:
30 30 frame/s (Non-drop)
30D 30 frame/s (Drop frame)
29.97 29.97 frame/s (Non-drop)
29.97D 29.97 frame/s (Drop frame)
25 25 frame/s
24 24 frame/s

(3 Output port

This indicates the type and number of the output port to which the channel is assigned.

(@ Channel select

This area lets you select the channel that is assigned to the output port.
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(3 Channel name
Indicates the name of the channel that is assigned to the corresponding output port.

(6 DELAY button
Switches the output port delay on/off.

(D Delay time
The millisecond delay time value is shown above the knob.
The delay time value in the units selected in the DELAY SCALE field (@) is shown below the knob.
Click the A/¥ buttons to make detailed settings.

DELAY TIME (Delay time knob)
This knob sets the delay time of the output port. Rotate (by dragging) this knob to set the delay time.

(@ @ (Phase) button

Switches the phase of the signal assigned to the output port between normal phase (black) and reverse phase (orange.)
It is not adjustable if the output-port is set to the RECORDER.

GAIN knob

Adjusts the gain level for the signal assigned to the output port. To change the value, rotate (by dragging) the knob in
the screen. You can adjust the setting in 0.1 dB steps over a range of -96 to +0 dB. The current value is shown immedi-
ately below the knob.

@) Level meter
This meter indicates the level of the signal assigned to the output port.
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Keyboard Shortcuts

Key operation

Menu Action
Windows Mac
Creates a new Session Ctrl+N #+N
File menu Opens a previously saved Session Ctrl+O ¥+0
Saves the current Session Ctrl+S ¥ +S
Undo Ctrl+Z $+Z
Edit menu
Redo Ctrl+Y #E+Y
Closes the active window Ctrl+W #+W
Closes all windows Ctrl+Alt+W 3 +Option+W
Tiles all windows Ctri+T 4T
Cascades all windows Ctrl+Alt+T 3 +Option+T
Opens the Main window Ctrl+1 3 +1
Opens the Sends On Fader window Ctrl+2 #+2
Opens the INPUT CH (CH1-16) window Ctrl+Alt+1 3 +Option+1
Opens the INPUT CH (CH17-32) window Ctrl+Alt+2 3 +Option+2
Opens the INPUT CH (CH33-48) window Ctrl+Alt+3 3 +Option+3
Opens the INPUT CH (CH49-64) window (CL5, 3) Ctrl+Alt+4 3 +Option+4
Opens the INPUT CH (CH65-72) window (CL5) Ctrl+Alt+5 3 +Option+5
Windows menu Opens the ST IN window Ctrl+Alt+6 3 +Option+6
Opens the MIX 1-16 window Ctrl+Alt+7 3 +Option+7
Opens the MIX 17-24 window Ctrl+Alt+8 3 +Option+8
Opens the MATRIX window Ctrl+Alt+9 3 +Option+9
Opens the STEREO/MONO window Ctrl+Alt+0 3 +Option+0
Opens the Selected Channel window Ctrl+3 ¥ +3
Opens the Library window Ctrl+4 $+4
Opens the Patch Editor window Ctrl+5 ¥+5
Opens the Virtual Rack window Ctrl+6 ¥#+6
Opens the Meter window Ctrl+7 ¥+7
Opens the Group/Link window Ctrl+8 ¥+8
Opens the Scene window Ctrl+9 ¥+9
Synchronization menu Opens the Re-Synchronize window Ctrl+0 #+0
Library window or Selects consecutive multiple items (memories) Shift+click shift+click
SCENE MEMORY page | Selects non-consecutive multiple items (memories) Ctrl+click & +click
of the Scene window Selects all memories in a section Ctrl+A H+A
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B
BYPASS oo 76,78, 82, 84
C
CLEAR ..o 56, 89, 91, 96
CLEAR ALL .......... 58,92, 97,99-105
CLOSE ..o 54,94
COMMENT .....oovrerreeerereeenrenes 95
Ctrl( 88 )+clicK oo 12
Ctrl( 38 )+Shift+Click ....ocovevevrrreerenee 12
Custom Fader Bank Setup window
.......................................... 105
Custom Fader Bank window ....... 106
D
DCA fader ....ccovevereveneernereecrnenens 30
DCA group ..o 89
DCA Window ......ccceeevcereeenceeencenenees 30
DIRECT OUTPUT PATCH page .. 62
E
Effect
GR meter ... 79
SOLO e 79
EFFECT module ......ccoovvuvcrrecnneneee 77
Effect parameters .......cooeveeevvcrence 80
EFFECT TYPE ....ccoovvvrecrrecrenen 78
EQ FLAT .. 69
-
FADE TIME page ......cccecovuvicunnee 100
FILE oo 55,94
File
ClOSE vvevereeeeeieeeeseeeeresnens 54,94
L5753 1 EN RO 54,94
FOCUS RECALL page .....cccveene.. 102
FROM MIX, ST/MONO(QC) .......... 50
G
GEQ faders ....cooeevvveeereeeieeecenee 69
GEQ graph ...cccceveeeeveeevcerecencreeneerenee 69
GEQ module ......ccooveeereiiiireinnee 67
Group/Link window ........cccccceueeuene 88
CHANNEL LINK page ............ 91
DCA GROUP ASSIGN page ... 88
MUTE GROUP ASSIGN page
......................................... 90
I
INPUT CH window .......cccoveeeeveerenee 16
INPUT INSERT PATCH page ...... 60
INPUT PATCH page .....ccceevuveunee 58
INTERNAL DATA .....ccovuennee. 56, 96

K
Keyboard Shortcuts .......c.ceceeunenee. 113
L
Library window ........cccoveeeeeuvecurenne. 54
M
Main window ......cccoeeeeuveeercrrercenennen. 13
MATRIX Bus Setup .....cccccvueuruiunnnns 18
MATRIX SEND ...ccooovriienrrinennes 28
MATRIX Window ......ccccceeveeeerceremnne 26
Meter Window .......ceeeuveeeercerecerennne 86
MIX BALANCE .....ccoovveerrrernenne. 79
MIX Bus Setup .....cccoceeeerirenininiuinnnns 18
MIX/CH/ST IN ..o 26
MIX/MATRIX SEND ......cccoeueueunae 33
MONO ..., 52
Mute roup .....cceveveeeceririnininininnnns 90
MUTE GROUP CONTROL .......... 90
MUTE SAFE ON ... 91
o
Offline Edit ...ccovverveveeverecerereecrnenee 12
OPEN ... 54, 94
Outport Setup window ................. 111
OUTPUT INSERT PATCH page ..61
OUTPUT PATCH page .....ccc.ou..... 59
P
Patch Editor window ........ccccecucnee. 58
DIRECT OUTPUT PATCH page
.......................................... 62
INPUT INSERT PATCH page ..60
INPUT PATCH page .....cceuuc... 58
OUTPUT INSERT PATCH page
.......................................... 61
OUTPUT PATCH page ........... 59
PATCH LIST page ....cccocovueueenee 63
PATCH LIST page ....ccccovuvvvuvicnnnes 63
PLAY/REC ..., 80
Premium Rack Library window ....57
PROTECT ... 95, 96
R
| 2021072 51 D 56, 96
Recall Safe ..., 97
RECALL SAFE page ......ccccoeuvuincnnne 97
REDO ..., 10
Re-synchronize .........coocoeivicnnanee. 12
S
SAVE ... 54, 94
SAVE AS .o, 54, 94
Save as a different name ........... 94

Save under a different name ....54
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SCENE MEMORY page .....ccoeeneee. 94
Scene window
FADE TIME page .....ccceceuueune. 100
FOCUS RECALL page ........... 102
RECALL SAFE page .....cocoveue.. 97
SCENE MEMORY page ........... 94
Selected Channel window .............. 31
Channel selection ... 32, 46, 50, 52
COMPANDER ......ccoovevrrrrerenee 41
COMPRESSOR, EXPANDER .. 39
DCA GROUP/MUTE GROUP
......................................... 45
DE-ESSER .....ccoovvvvverereerrrrennen 42
EQUALIZER .....cveverererenene 37,48
Fader .....coceuvvvverenenee 45,49, 51,53
FROM MIX, ST/MONO(C) .... 50
GATE/DUCKING .....ccoeveveveee. 38
HA/D.GAIN/HPF/Q/GC ........ 34
Input channel ......cccoovcrvevcrnenne.
INSERT ...cooveverererernnnns
MATRIX channel .....................
MIX channel ........ccceeveverrrernene.
MIX/MATRIX SEND
RECALL SAFE/MUTE SAFE .. 44
STEREO/MONO channel ....... 52
TO MATRIX ..o 46
TO STEREO/MONO ......... 36,47
Sends On Fader window .............. 110
SET ALL oo 97,99
Setup
LY 555 QR 3
SYstem ..., 2
ST IN Window .....cceeeeerereeeeeeerereennne 21
STEREO/MONO window ............. 28
STORE ..ot 56, 96
Synchronization .........c.cccveevevceenee 12
SYNchronize .......ccveeveerveerevcenenees 12
T
TabS wveveeeeeeereeeeeee e 11
TEMPO ..o 79
TIME STAMP ... 96
U
UNDO e 10, 56, 96
User Defined Keys Setup window
.......................................... 107
User Defined Knobs Setup window
.......................................... 108
USERKEY ..o 4
\'
Virtual Rack window ...........ccoue.... 65
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